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 CAUTION !

Always plug the system components, i.e., the Personal Computer (PC)
installed with the Goniometric Radiometer 880GS Controller Card, and
the Model LD 8900 or LD 8900R Motion Control Unit, into a grounded
power outlet strip with surge protection. Spiricon does not warrant
damage due to power line surges.

ALWAYS BE SURE the AC power is OFF when connecting or
disconnecting anything to or from the instrument and or the PC.

The 880X Card can be damaged by electrostatic discharge (ESD). To
prevent ESD damage that can occur when handling electronic
equipment, it is recommended to use a ground strap or similar device
when performing this installation procedure and in general handle the
card without touching the gold fingers. Use standard laboratory safe
ESD practices.

When measuring high power laser sources, start at low power and
approach higher laser powers slowly from low to high power; Spiricon
does not warrant damage due to high power laser sources.

Be sure to connect the 9-pin D-subminiature cables to the proper
places. Accidentally connecting the RS-232 cable from the PC to the
Scan Head may cause damage to the motion control system motor!

Verify that the software you received is compatible with your PC
Operating System. The Goniometric Radiometer Acquisition and
Analysis Software is designed for use with the most current version of
Microsoft Windows® Operating System.

Measurement Accuracy and Repeatability

The accuracy and repeatability of results obtained with the Goniometric
Radiometer depend on the mode of operation and the positioning
and alignment of your diode or optical source.
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Trademarks

The Goniometric Radiometer Model LD 8900™, LD 8900R™ and Goniometric
Radiometer Acquisition And Analysis Software™ are trademarks of Ophir-
Spiricon, LLC.

MS Windows® is a registered trademark of Microsoft Corporation.

Patents

The Goniometric Radiometer Model LD 8900/LD 8900R is protected under
US Patent #5,949,534.
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. Introduction

1.1. System Overview

The Model LD 8900/LD 8900R Goniometric Radiometers are “real time”
angular scanning optical instruments designed to rapidly measure the
intensity distribution of widely divergent optical sources such as
non-collimated Laser Diode sources and Light Emitting Diodes.

These instruments are based on a patented proprietary scanning technique
where neither the detector nor the light source moves. Using this method,
full goniometric scans are performed in fractions of a second, allowing for
complete hemispherical intensity distribution measurements in times on the
order of about a minute. Measurements of this type used to take hours,
days, or even weeks.

These instruments provide:

¢ Fast and accurate measurement of radiation pattern from highly
divergent light sources;

Angular sampling interval of 0.055°, with 3241 data points per scan;
Azimuth sampling at intervals of 0.225°;
Single Azimuth Scans at 5 Hz rate;

Orthogonal Azimuth Scans at 1 update every two seconds;

* & & oo o

Full 3D characterization with 200 azimuth scans at 0.9° intervals,
(648,000 data points) in less than 2 minutes;
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The LD8900/LD 8900R is a modular unit intended for use in research and
development, in manufacturing environments, and for custom applications.
The design allows unobstructed access to the instrument entrance aperture
and provides the greatest flexibility for integration into any inspection
system. It is ideally suited for testing of a wide variety of sources, such as
laser diodes mounted onto large heat sinks or on test bars or even at the
wafer level. The system is available with either a Silicon detector or an
InGaAs Detector:

« The Silicon Detector is for sources emitting between 320nm and
1100nm wavelength.

e InGaAs Detector is for sources emitting between 800nm and
1700nm wavelength.

The detectors cannot be easily changed.

The LD 8900 systems use an 8-bit Analog-to-Digital Converter (ADC); the
LD 8900R systems have a 16-bit ADC.

The LD 8900/LD8900R can be used to measure both CW and pulsed
sources; however the measurement of pulsed beams should be undertaken
with care. Due to the way that the signal amplifier circuits operate there are
some pulsed conditions that yield erroneous results. Spiricon offers a pulsed
operation option to alleviate this problem. Please refer to the Chapter 5.8
“Operation of the Goniometric Radiometer with Pulsed Sources” for more
information on this subject.

Knowledge of MS Windows Operating Systems Prerequisite for Use
The Goniometric Radiometer Acquisition and Analysis Software for MS
Windows is easy to learn and use. However, it is assumed that users have
at least a basic working knowledge of the MS-Windows Operating Systems.
As such, this manual does not address the basics of MS Windows
operations. First-time users of MS Windows will need to spend some time
becoming familiar with the basics of Windows. For further assistance on MS
Windows, consult your MS Windows manuals, tutorials, or Help.
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1.2. Product Description

The Model LD 8900/LD 8900R System consists of:
v’ The Scan Unit;
The Motion Controller Module;
The Model 880GSX Scan and Data Acquisition Controller;
The Model 880X PCI Interface Card

N XN X X

Goniometric Radiometer Acquisition and Analysis Software with
the most current Windows® operating system CD.

v Power and Instrument Cables.

The LD8900/LD 8900R Scan Unit is a component that requires two (2) user-
provided mounts before operation of the system. One is to mount the
instrument itself, and the second is to mount the device to be tested.
Detailed engineering drawings are provided to aid in this design.

Initial unpacking, system configuration, system startup, and operation of the
LD8900/LD 8900R are described in detalil in this manual.
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2 . System Inspection

2.1. Inspection

Your Goniometric Radiometer has been carefully tested, inspected and
packaged before shipment. Spiricon performs extensive testing to ensure
that the unit is in proper working order. Upon receipt of your Goniometric
Radiometer, please do the following:

Voo you have not already done so, inspect the shipping
container for any damage. Please report any damage found
immediately to the shipping company. Spiricon does not
warrant damage that occurs as a result of shipment.

v' Check the contents of your shipment against the packing slip
attached to the shipping box. Please note any discrepancy.

2.2. Packing List

1. LD 8900/LD 8900R Goniometric Scan Unit.

LD 8900/LD 8900R Motion Controller Module.

3. 880GSX Digital 1/0 Interface Unit (LD 8900 with 8-bit Scan
and Data Acquisition Controller inside; LD 8900R with 16 bit
Scan and Data Acquisition Controller inside).

4. 880X PCI Interface Card

5. LD 8900/LD 8900R Goniometric Radiometer Acquisition and
Analysis Software CD.

6. RS-232 Communication Cable, 9-pin D-subminiature male to
9-pin D-subminiature female.

7. Scan Unit Signal Cable (Black — ~3m length), 37-pin D-
subminiature male to 37-pin D subminiature female.

8. 880GSX Scan and Data Acquisition Controller Signal Cable
(Beige/Gray - ~1m length); 37-pin D-subminiature female to
37-pin D subminiature female.

9. Motion Controller cable, 9-pin D-subminiature male to 9-pin
D-subminiature female.

10. AC Power Cable.
11. USB to RS232 serial COM port adapter. (p/n 7E10040)

N
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3 . System Setup

Setting up the LD 8900/LD 8900R Goniometric Radiometer requires
Software installation, Hardware installation, and Component configuration.

3.1. PC Requirements

The following are the minimum PC requirements for the LD 8900/LD 8900R
Goniometric Radiometer software. The minimum requirements for different
versions of Windows may be different, in this case use the higher system
requirements.

CPU: 1 GHz Pentium 4 Celeron, or better

OS: Windows Vista Business or Windows 7 Business or
Professional, 32 or 64 bit.

PCI: 1 Open slot

RAM: 2 GB

Video: Minimum resolution of 1024x768

3.2. Software and PCI card Installation

Note: The following software installation must be performed prior to
installing and connecting any of the supplied Gonio hardware.

There may be minor differences to what is written here depending on the
version of windows and the PC’s auto launch settings. The procedure
described here reflects Windows 7 (except where noted).

Note: This software must be installed with Administrator Privileges.
The Software installation requires these steps:

1. Driver Installation for 880X PCI Interface Card

2. 880X PCI card installation and configuration

3. Goniometric Radiometer Acquisition and Analysis Software
Installation

4. Software Configuration

Insert the supplied DVD; if the installer doesn’t start automatically, navigate
to the DVD drive and double-click on the file named Amplayer.exe.
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Click on the Software Install button.

Welcome to the installation navigator OPH?H
Srenmome &0 SHCON | ) Photon

Software Install

Welcome to the installation navigator.

Broduct Manuals This disk contains your software and all

necessary support products for you to install and

Beam Profile Tutorial manage the Spiricon product you just purchased.

Customer Service Should you need assistance, our contact

information is also provided.
Product Catalog

Thank you for your confidence in Ophir-Spiricon.
Sensor Finder

Contact

Free Gift

Click on the 1. Install Driver button.

S,
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3.2.1. Driver Installation for 880X PCI Interface Card

On the following five screens, click OK, Setup, Next, Next, Install.

WinzipSeIf—Bclractorl ‘ @

Press OK to continue with installation.

oK |[ Cancel ]

WinZip Self-Extractor - icalsetupM -
% Click on Setup to install InstaCal.

About

) InstaCal for Windows - InstallShield Wizard S5

Welcome to the InstallShield Wizard for
InstacCal for Windows

The InstallShield(R) Wizard will install InstaCal for Windows on
your computer. To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

MEASUREMENT
COMPUTING

| < Back [ Mext > ] [ Cancel
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%) InstaCal for Windows - InstallShield Wizard S5

Destination Folder y :\ MEASUREMENT
COMPUTING

Click Mext, or dick Change to install to a different folder.

G Install InstaCal for Windows to:
C:'\Program Files\Measurement Computing\DAQY

Installshield

<Back || Mewtx | [ Cancel
4 InstaCal for Windows - InstallShield Wizard S5
Ready to Install the Program Vs ?.\‘ MEASUREMENT
COMPUTING

The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

InstallShield

< Back ]| Install i [ Cancel

Depending on the operating system you may see several of the following
type of message, Click Install on each one.

_——
[57] Windows Security lﬁ
Would you like to install this device software?
MNarne: Measurement Computing Corp. DAS Componen...
CF| Publisher: Measurement Computing Corporation
[T Always trust software from "Measurement Install ] [ Don't Install l
Computing Corporation”.
';ﬁ‘ You should only install driver software from publishers you trust. How can [ decide which device
software is safe to install?
8 =
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Click Finish.

r -
2 InstaCal for Windows - InstallShield Wizard [

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed InstaCal for
Windows. Click Finish to exit the wizard.

[ show the readme file

MEASUREMENT
COMPUTING

You must restart your system for the configuration
changes made to InstaCal for Windows to take effect.
Click Yes to restart now or Mo if you plan to restart
later.

3.2.2. 880X PCI Installation

Close all open programs, turn off your PC, and remove the case to allow
access to the motherboard.

1. Install the Goniometric Radiometer PCl 880X card in any
available PCI slot. This card may be marked PCI-DIO24.

Do not connect the cable to the card at this time.

Close the PC case, turn your PC back on, and allow it to fully
reboot.

Windows 7: You will see some notifications that the driver is being installed.
The driver installation requires no user action. Wait until the final notification
is received before continuing on to step 3.2.3 880X PCI Configuration.
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i) Found New Hardware

Your new hardware is installed and ready to use.

Windows XP: After booting up, Windows will automatically detect the board
and the Found New Hardware dialog box will appear stating that a new PCI
Device has been detected and will be installed:

i) Found New Hardware
PCI Device

When the Found New Hardware Wizard starts, Windows XP may present a
dialog box asking you if it can connect to Windows Update to search for the
driver. Choose No, not this time. Windows update does not have drivers
for this card.

Found New Hardware Wizard

Welcome to the Found New
:‘l‘?\ Hardware Wizard

Windows will search for cument and updated software by
looking on your computer, on the hardware installation CO, or on
the Windows Update Web site (with your pemission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

™ Yes, this time only

Click Mext to continue.

¢ Back et = Cancel

Select Install the software automatically (Recommended) and then click
Next:
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Found New Hardware Wizard

5

This wizard helps you install software for:
PCI-DI024

Z;-jl i your hardware came with an installation CD
a2 or floppy disk. insert it now.

What do you want the wizard to do?

" Install the software automatically (Recommended)

™ Install from a list or specific location (Advanced)

Click Meat to continue.

< Back et = Cancel |

Windows will detect the appropriate drivers for your card, and install them
for your card, when it is done click Finish.

Found New Hardware Wizard

Ny Completing the Found New
& Hardware Wizard
3

The wizard has finished installing the software for:

_\> PCI-D1O024

Click Finish to close the wizard.

< Back

Carcel |

The Found New Hardware Wizard will exit and windows will display a
message box stating that your new hardware is installed and ready to use.
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3.2.3. 880X PCI Configuration

Navigate to the DVD drive and double-click on the file named Amplayer.exe

The following window will appear. Click Software Install.

Software Install

Product Manuals

Beam Profile Tutorial

Customer Service

Product Catalog

Sensor Finder

Contact

Free Gift

Welcome to the installation navigator.

This disk contains your software and all
neceszary support products for you to install and
manage the Spiricon product you just purchased.

Should you need assistance, our contact

information iz alzo provided.

Thank you for your confidence in Ophir-Spiricon.

Click on the 2. InstaCal button.

[@ Photon Insta
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The Plug-and-play Board Detection dialog box will pop up after a few
moments. Click OK to select the indicated card.

B
Plug and Play Board Detection @

The following plug and play devices have
heen detected...

[wIPCI-DI024 [bust 4, devit 2]

Check those devices you wish to have
added to the configuration file.

The following main window from the InstaCal software will appear. Take note
of the board number assigned to the card. Normally it should be #0.

[ nstacal (= [ [ |

File Install Calibrate Test Help
]
= Ps.

™ §C Board List

=i PCIExpansion (bus 4)
B8 - JBoard# 0 - PCI-DIO24 (dev# 2)

Ready MUM

he

Close the InstaCal software main window. You will not need to run this
software again, but in order for the Goniometric Radiometer software to
run properly this software must remain installed on the PC.
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3.2.4. Goniometric Radiometer Acquisition and Analysis
Software Installation

Click on the 3. Install Software button.

{&d Photon Installer

On the following screens click Next, then Next again.

Read through the Ophir-Spiricon license agreement. If you agree to abide
by the license terms and conditions, accept by choosing the | accept the
terms in the license agreement button.

License Agreement
Please read the following license agreement carefully.

OPHIR-SPIRICON, LLC Software License
Agreement
CAREFULLY READ ALL THE TERMS AND CONDITIONS OF
THIS AGREEMENT PRIOR TO INSTALLING THE PROGRAM.
INSTALLING THE PROGRAM INDICATES YOUR ACCEPTANCE
OF THESE TERMS AND CONDITIONS.

3

Ownership

. o -
Mirhir Sririean 1L e tha anclacad cofhamrn nranrame and

i I accept the terms in the license agreement "
(7)1 do not accept the terms in the license agreement

InstallShield

<Back || MNext> || Cancel

Click Next, then Next again.
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On the following screen choose either Anyone who uses this computer or
Only for me. If you are unsure of the correct option, ask your system
administrator.

Ready to Install the Program
The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Install this application for:

[ Anyone who uses this computer (all users) ]

[ Only for me (Newport Corporation) ]

InstallShield

Wait for the installer to complete, then click Finish. You will be asked again
to reboot. At the following prompt click No.

Goniometric Radiometer R Installer Information —ﬂ

changes made to Goniometric Radiometer R to take
effect. Click Yes to restart now or No if you plan to

& ‘You must restart your system for the configuration
| restart later,

Select Quit on the Photon Installer, eject the install CD, close all programs,
and turn off the PC before proceeding to the next section.
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3.3. Hardware Installation

The PCI 880X card and driver must have already been installed during the
previous software installation sections

3.3.1. LD 8900/LD 8900R Scan Unit Mounting

Before applying power to the LD 8900/LD 8900R system, it must have all
cables securely and properly connected; and the scan head must be
mounted securely (for example, an optical table or stable mechanical
fixture). Failure to do this may cause damage to the unit.

WARNING: Never connect or disconnect the motor drive cable with
power applied to the Motion Controller. Doing so may cause
permanent damage to the controller.

WARNING: Verify that the Motion Controller’s line voltage switch is
correctly set to match the local AC mains. Connecting the Motion
Controller to a 220V 50 Hz supply with the mains switch set to 110V will
immediately damage the controller.

NOTICE:

The Motion Controller may be fitted with an externally accessible fuse.
Never replace this fuse under any conditions. Doing so may cause
permanent damage. Return the unit to Spiricon for servicing. The

Motion Controller contains no user serviceable parts.
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3.3.2. Component Connections

Make the following component cable connections according to the diagram
below with all AC power off. Or you can use the written instructions on the
following page.

CAUTION! VERY IMPORTANT! CAUTION!

Be careful to make the proper connections: Please match the color dot
on the connector to the same color dot on the proper component!
Improper connections will cause serious damage to the system!

V TO SCAN UNIT
MOTION CONTROLLER@
— TO RS-232/COM PORT

RS-232 COM PORT

LD 8900
SCAN

UNIT ﬁ
| |

\
N
i\

L

880X PCI-D/IO

© 880 GSX .

After all of the above cable connections are securely made, proceed to step
9 in the following instructions.
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LD 8900 and LD 8900R Goniometric Radiometer Cable Connections

1. Connect the female end of the 37-pin Black Signal Cable to
the LD 8900/LD 8900R Scan Unit

2. Connect the male end of the 37-pin Black Signal Cable to the
Model 880GSX Scan and Acquisition Controller connector
labeled “SCAN UNIT”. CAUTION! Never connect this cable to
the “880X PCI D/IO” connector.

3. Connect one female end of the 37-pin Beige/Gray Signal
Cable to the Model 880GSX Scan and Acquisition Controller
connector labeled “880X PCI D/IO”. CAUTION! Never connect
this cable to the “SCAN UNIT” connector.

4. Connect the other female end of the 37-pin Beige/Gray Signal
Cable to the “880X PCI D/IO” card installed in the PC.

5. Connect the female end of the 9-pin RS232 cable to the PC
COM1 or COM2 serial port. (Spiricon supplies a USB to
RS232 adapter for PC’s that lack a serial COM ports.)

6. Connect the male end of the 9-pin RS232 cable to the
LD 8900/LD 8900R Controller. CAUTION! Never plug the
RS232 cable into the LD 8900/LD 8900R Scan Unit. It may
damage the unit.

7. Connect the female end of the 9-pin Motion Controller cable to
the LD 8900/LD 8900R Controller.

8. Connect the male end of the 9-pin Motion Controller cable to
the LD 8900/LD 8900R Scan Unit.

9. Connect AC power cords from the PC and the LD 8900/
LD 8900R Motion Controller to a power outlet strip with surge
protection.

10. Connect your monitor power cord to the power outlet strip.

11. Connect the power outlet strip to a properly grounded AC
power outlet.

12. Turn on the power outlet strip.
13. Turn on the PC & Monitor.
14. Turn on the LD 8900/LD 8900R Motion Controller.

Note that the LD 8900/LD 8900R Scan Unit is powered via the
cables connecting it to the PC system.
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3.4. Software Configuration

After reboot is complete the Goniometric Radiometer Configuration
dialog will open as shown below. If this dialog fails to appear you may start
it manually. Go to Start->All Programs->Photon->Gonio Configuration.

Choose the PCI Interface. Enter the board number you noted earlier from
InstaCal into the CB Num edit box. Choose the COM# that you have
connected to your motion controller. (If you are using the supplied USB to
RS232 adapter the default serial port is normally COM4.)

Set the 1/0O Address to match the indication on the 880 GSX unit. Click OK
to save the settings.

r . Goniometric Radiometer Configuration &J
/0 Address . |(300 | Ok,
COM Port : - _ Cancel |
Interface
£ 154,
& Pl CE Mum |0 Help

This completes the software and hardware installation procedures.

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 30



4 . Diode Installation

The Model LD 8900/LD 8900R is a modular unit intended primarily for use in
manufacturing environments and for custom applications. The design allows
unobstructed access to the instrument entrance aperture and provides the
greatest flexibility for integration into any inspection system. It is ideally
suited for testing of a wide variety of sources, such as laser diodes mounted
onto large heat sinks or on test bars, or even at the wafer substrate level.

4.1. Instrument Optical Axis Alignment Relative
to Reference Datum Plane

The mechanical alignment of the Optical Axis of the LD 8900/LD 8900R
relative to the Datum Reference Plane due to the RMS mechanical
tolerances has an RMS specification of better than +0.2°. Device mounting
is very important if you want results that are accurate relative to the
instrument optical axis.

4.2. LD 8900/LD 8900R Diode Mount
Considerations

With the LD 8900/LD 8900R it is first necessary to securely attach the Scan
Unit to some stable mechanical surface or part. Second, it is necessary to
design and incorporate a Custom Diode Mounting Fixture to position diodes
for test at the instrument Entrance Aperture and point them along the
instrument Optical Axis. Figure 4-1, Figure 4.2, and Figure 4-3 provide the
information necessary for mounting the LD 8900/LD 8900R and for the
design of Custom Diode Mounting Fixtures.
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ALTERNATE ROTATION

DATUM PINS FOR
MOUNTING PLATES SIGNAL CABLE
AND FIXTURES

MOTOR CONTROLLER

2mm ENTRANCE APERTURE

ROTATION MOUNT SCREWS

y USER PROVIDED STAND
DATUM SURFACE | j/ (MUST BE BOLTED TO
P TABLE DURING USE)

Figure 4-1. lllustration of the LD 8900/LD 8900R Mounted in 2 Different Orientations.

The illustration shows the Entrance Aperture Datum Surface, the locations
of the Alignment Dowel Pins, and the Signal and Motion Controller
Connectors.

€
0,05 DATUM

500 —=

P
Waﬁmwwom PIN 2plcs
52504009 f\ J“ 6560

3
f \ T (0,05 DATUM
2625005
& /

3.280
.

8-32 UNC-2B THRU% 2625

4ples

5250 —=

¢ g ¢
€0,0> DATUM |7 \(0,0) DATUM
!

1/4-20 UNC-2B
dplcs AN

MOUNTING TAB 3.782
/ MOTOR CONTROLLER i j

1,000 30
:
JE /SIGNAL CABLE

!

500 ~f k-t

1000 —= =

25 TYP 6.50

Figure 4-2. Detailed Mechanical Drawing showing the Dimensions of the
LD 8900/LD 8900R Scan Unit
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Xa
DISTANCE FROM DIODE CAN
TO DATUM SURFACE

THE VALUE OF X2 MUST BE AS SMALL

AS POSSIBLE FOR WIDEST FIELD ANGLE 2mm ENTRANCE APERTURE

X4+ Xp= APERTURE—SOURCE DISTANCE
(ENTER INTO SOFTWARE)

X4

DISTANCE FROM
DIODE JUNCTION TO OUTSIDE
SURFACE DIODE CAN

— OPTICAL AXIS &)
SN 0O N~
DIODE JUNCTION \ >t

Figure 4-3. lllustration showing the positioning of a diode at the Entrance Aperture of the
LD 8900/LD 8900R, and the determination of the Aperture-Source Distance for a low
divergence diode source

Lateral positioning with respect to the Optical Axis should be accurate to
tolerances on the order of £0.127 mm (+0.005”). The instrument will then
provide the most accurate measures of angular widths and pointing.
Measurements of pointing accuracy are significantly affected by lateral
positioning errors, but angular width is not.

Pointing positioning with respect to the Optical Axis should also be as
accurate as possible. Similar to lateral positioning errors, pointing
positioning errors affect measurements of pointing but not angular width.
Note! Typical diode header tolerances are 1°, not including the
mounting tolerances of an actual emitting junction.
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5 . System Measurement
Overview

This chapter is an overview describing the basic mechanical and operating
features of the LD 8900/LD 8900R hardware and software features that
affect the measurements and the reported parameters. Users should be fully
aware of these features first to understand the measurements performed
and second in order to ensure the highest possible measurement accuracy.

Measurements made using the LD 8900/LD 8900R depend on the scan
mode, user entered parameters, system algorithms and the positioning and
pointing of the device under test.

5.1. Scan Modes

The Goniometric Radiometer acquires data in 1 of 3 scanning modes:
1. Single Axis Scan Mode
2. Perpendicular Axes Scan Mode, or
3. 3D Scan Mode.

The Single Axis and Perpendicular Axes Modes provide the fastest data
updates. However, the data obtained are strongly dependent on how well
the device under test is positioned relative to the optical axis of the LD
8900/LD 8900R instrument, and also on the pointing of the device.

In all three modes, the scans are made about the optical axis of the
instrument. The scan geometry is eccentric; hence the raw scan data is not
obtained at constant radius from the source. Therefore, to obtain the
intensity at constant radius from the source, geometric corrections are
applied to the raw data. This geometric correction depends on the Aperture-
Source Distance parameter, which the user must enter into the software. It
is extremely important to enter the proper value in order that the reported
angular widths and positions are accurate. The nominal scan distance is
(8.27 cm + Aperture-Source Distance).
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5.2. Field of View

The Aperture-Source Distance determines the instrument field of view. The
maximum field of view of +72° is when the Aperture-Source Distance is zero,
i.e., the source is positioned at the datum reference plane. As the source is
moved away from the reference datum, the field of view decreases. Table 5-
1 gives the field of view for different Aperture Source Distances

Table 5-1. Goniometric Radiometer Field of View
for Various Values of the Aperture-Source Distance

Aperture-Source | Field of View Aperture-Source | Field of View
Distance (cm) (degrees) Distance (cm) (degrees)

0 +72.01 3.5 + 39.97
0.1 +70.99 4.0 + 35.84
0.2 +69.99 4.5 + 32.55
0.3 + 69.00 5.0 + 29.84
0.4 + 68.02 6.0 + 25.63
0.5 +67.06 7.0 +22.50
0.6 +66.11 8.0 + 20.06
0.7 + 65.17 9.0 +18.11
0.8 + 64.25 10.0 +16.51
0.9 +63.34 11.0 +15.17
1.0 + 62.45 12.0 +14.05
15 + 58.20 13.0 +13.06
2.0 + 54.30 14.0 +12.21
2.5 + 50.75 15.0 +11.46
3.0 + 45.35 20.0 + 8.79

5.3.  Acquired Scan Data

The scan data is acquired about the instrument optical axis, with the
different ¢ azimuth angles specified relative to this axis. The data taken for
each azimuth angle is a set of sampled signal amplitude values and
corresponding scan angles, designated by the 8 scan angles.

For each scan mode, the data acquired in each scan for a given ¢ azimuth
angles consists of 3241 data points taken at ~0.055° increments in the &
scan angle. A 3D scan with 200 azimuthal scans yields a data set with
648,200 data points.

Data acquired when operating the system in either Single Axis or
Perpendicular Axes Scan Modes can be displayed in real-time in the
Rectangular View or Polar View windows of the Goniometric Radiometer
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Analysis Software. Data acquired in the 3D Scan Mode can be viewed in
various 3D image formats, or individual scan data can be viewed using the
Replay feature of the software. These software features are discussed in
Chapters 6 (LD8900) and Chapter 7 (LD8900R).

5.4. Processed 3D Scan Data

After a 3D scan acquisition, the data is first processed to compute the 3D
Centroid of the intensity distribution. Next, the 2 principle axes of the
distribution about this centroid, also known as the major and minor axes, are
determined. These principal axes, together with the centroid axis, define 2
principal planes. These planes are then used in an algorithm to generate
scan data along the major and minor axes, or along any axis through the 3D
Centroid. This is done by interpolating the original scan data acquired about
the optical axis. The processed data generated in this way can be viewed
using the 3D Centroid Replay feature of the software, discussed in section
Chapters 6 (LD8900) and Chapter 7 (LD8900R).

5.5. Blind Spots

The scanning mechanism of the Goniometric Radiometer incorporates two
support structures, which cause blind spots in the scan for a limited range of
¢ azimuth angles. These blind spots are approximately 3.7° wide and occur
at different ranges of 8 angles in the scan data depending on the ¢ azimuth
angle. Also, the angular positions of the blind spots are a function of the
Aperture-Source Distance.

The blind spots are present for ¢ azimuth angles ranging from greater than
97° to less than 353°. Consequently, data taken at the nominal azimuthal
scan angles of 0° and 90° are not affected. Furthermore, for data acquired at
¢ azimuth angles in the range from 97° to 353°, depending on the angular
width of the source, the blind spots may or may not affect the scan data. For
example, for ¢ = 108° the blind spot occurs in the scan data from
approximately 8= -65.8° to §=-69.5°. So, if the source extends only to 25°,
the blind spot will not affect the data. However, if it extends to 68°, the data
will be affected.

An example of scan data with blind spots, displayed in the Rectangular View
window, is given in Figure 5-1. The azimuth angles for these scans are 135°
and 225°. An example of a 3D acquisition with blind spots, displayed in the
Topographic View window, is given in Figure 5-2. Here the effect of the blind
spots can be seen as a void spiraling away from the center of the image.
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ectangular Yiew - Photon inc.

Phi = 135.000°

Figure 5-1. An example of scan
data with blind spots, displayed
in the Rectangular View window.
One blind spot is visible in the
W 135° azimuth scan and 2 blind

90" 80" 70" 760" 50" A0 -30° 20 10" 00 10" 30° S0° 400 B0 60 F0 80" G0 spots are visible in the 225°
Amplitude (Relative units) Phi = 225.000° azimuth scan.

Figure 5-2. An example of a 3D
acquisition with  blind spots,
displayed in the Topographic
View window. Here the effect of
the blind spots can be seen as a
void spiraling away from the
center of the image to the lower
right.

The presence of blind spots will affect the results of all analyses in the
Goniometric Radiometer analysis program, but to varying degrees. For
example, angular width measurements will be affected if the clip level
amplitude includes the blind spot. In this case the width would be reduced
by at most the blind spot width. Therefore, the percent error will be inversely
proportional to the width of the source, with a lower percent error for a
broader source. Amplitude measures will be totally in error if the blind spot
falls at the location at which amplitude is reported. Power calculations will
also be affected, with the percent error once again inversely proportional to
the width of the source pattern. Typical errors in the power calculation are
conservatively estimated to be at most at the 3-5% level. This estimate is
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based on an analysis of an intensity distribution that is uniform over all
azimuth angles (0°...360°), in which case the two 3.7° blind spots decrease
the total power integral by only 2%.

To further reduce errors associated with the blind spots, an algorithm, called
“Blind Spot Correction”, can be implemented in the Goniometric Radiometer
Analysis Software. This algorithm is described in the next section.

5.6. Blind Spot Correction

Blind Spot Correction is an algorithm to partially correct the data in the blind
spots. The algorithm first locates the position of the blind spots depending
on the azimuth angle ¢ and the Source-Aperture Distance. Then, a linear
interpolation is made between valid data points on either side of the blind
spot.

Data with blind spot correction applied is given in Figure 5-3 and Figure 5-4.
For comparison, Figure 5-3 shows data for the same source as that in
Figure 5-1 except with blind spot correction applied. Similarly, the data in
Figure 5-4 is for the same source as that shown in Figure 5-2 except with
blind spot correction applied.

ectangular Yiew - Photon inc.

nmplrtude {Relative units) Phi = 135.000°

Figure 5-3. An example of
scan data with Blind Spot
Correction applied, displayed in
the Rectangular View window.
For comparison, this data is for

-9l 807 70 -60 50 -40° 300 -200 -100 O 100 200 300 400 500 60 70 B0 90; the same source as that N
nmplrtude {Relative units) Phi = 225.000 figure 5_1 except Wlth Bllnd
Spot Correction applied.

et
-90° -§0° -70° -60° -50° -40° -30° -20° -10° 0 10" 200 300 40 500 &0° 70 807 907
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Figure 5-4. An example of a 3D
acquisition with Blind Spot Correction
applied, displayed in the Topo-
graphic View window. For
comparison, this data is for the same
source as that in Figure 5-2 except
with Blind Spot Correction applied.
Here the blind spot void is no longer

visible.

5.7. Device Positioning and Pointing

The acquired data and the values of reported parameters are strongly
dependent on the positioning and pointing of the source relative to the
Goniometric Radiometer. The user must supply the source mount, and to
facilitate the positioning of the mount, alignment pins with location
tolerances of +0.127mm (+£0.005”) are provided.

For a device, which is pointing perfectly along the optical axis, changes in
lateral position relative to the optical axis will have a significant effect on the
reported centroid (pointing) values. A lateral shift in position of 1mm will
result in a shift in centroid value of 0.68°. A lateral shift to the other side of
the optical axis by 1 mm will result in a centroid value of -0.68°. So, with the
same device, a spread in centroid value of 1.36° can be obtained, even
though, we know that the device was pointing perfectly, i.e., at 0°. This
example highlights the importance that positioning plays in the interpretation
of measurement results. It is extremely important to position your device as
close to the optical axis as possible in order to obtain the highest quality
data.

The effect of lateral translation on the reported angular width parameters
depends on whether the translation is along the scan direction or
perpendicular to it. If the translation is along the scan direction, angular
width parameters are not affected. If the translation is perpendicular to the
scan direction, the variation in the reported angular width depends on the
source distribution.

For a device that is positioned exactly at the optical axis, but which points at
some off-axis angle, the scans made in the Single Axis and Perpendicular
Axes Modes may not capture the principle axes of the source radiation
pattern. For example, scan data acquired for a laser diode device pointing at
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an angle of 5° to the optical axis and with the fast and slow axes oriented
along the 45° and 135° azimuth angles will not capture the “proper” scans.
The resulting numeric data will not faithfully represent the radiation pattern
of the source. In cases like this, the 3D scan mode should be used.
Although it takes more time, the data acquired can completely characterize
the source, with analysis yielding the 3D Centroid of the spatial light
distribution, as well as the mathematically reconstructed scans through the
principle axes as described previously.

5.8. Operation of the Goniometric Radiometer
with Pulsed Sources

Some customers may want to operate laser diode sources in the pulsed
mode for measurement in order to eliminate the need for cooling of the
chips. To operate in this way, either:

1. Define the actual operating space, i.e., the pulse width, frequency
and power level that you will be operating with and contact Spiricon
for advice on the application.

2. Or alternatively, try your application in the pulsed mode and compare
your results with CW operation. If it is the same, use it, but be aware
that even slight changes to the operating conditions can cause the
results to be in error.

We have discovered that measuring pulsed sources with the goniometric
radiometer is not straightforward. Although pulsed operation is possible,
there are some parameter combinations that can cause inaccurate
measurements. Because there can be unidentified saturation of some
internal stages of the preamplifiers in the systems, some frequencies, pulse
widths, duty cycles and power levels will work fine and others, which are
scarcely different will create erroneous results. InGaAs and Silicon detector
systems have different responses and operating spaces, but they both can
generate erroneous results under some conditions.

The Photon Goniometric Radiometer Software has a pulsed operation mode
that asks the user to input the pulse frequency. This software feature will
accept values as low as 100Hz. Although the system will work and give no
error messages, it is possible that the results obtained in this mode will be
inaccurate. Spiricon provides a hardware upgrade for pulsed operation of
the Goniometric Radiometer, which has corrected the errors inherent in the
electronics and is guaranteed to give accurate results for pulsed sources
operating at or above 10 kHz. Operation below this frequency is possible,
but care must be taken to ensure that the results are accurate. One should
always compare the pulsed results with those obtained while running the
source in CW mode. Any differences observed will be the result of errors
introduced by the combination of the pulse rate and the power. It should be
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possible to find a combination of these parameters that result in accurate
measurements, but Spiricon recommends that pulsed sources be measured
only with the Pulsed Option installed and with the source operated at 10kHz
or above.

5.9.  Summary

The interpretation of data acquired using the LD 8900/LD 8900R
Goniometric Radiometer depends on the mode of operation, the positioning
and pointing of the device under test, and user entered parameters. Use the
Single Axis and Perpendicular Axes Scan Modes to acquire data at the
fastest rates and when the distribution of the source is already well known.
These modes are very useful for autonomously acquiring statistical data of
devices over long periods of time, during burn-in or life testing for example.
Use the 3D Scan Mode to provide the most complete characterization of a
source. Finally, to obtain accurate angular width and pointing data, be sure
to enter the proper value of the Source-Aperture Distance.
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6.1.

LD 8900 Acquisition
and Analysis Software

Quick Start

1. Turnon the PC.

2. Turn on the Goniometric Radiometer.

3. Start the Goniometric Radiometer Program by double-
clicking on the program icon on your monitor screen; or,
from the Windows Start menu, select Programs, then
PHOTON, and then Goniometric Radiometer.

4. After a few moments a message will appear informing the
user that the RS-232 Communication link is being
established, with a reminder to set the Aperture-Source
Distance.

E stablizhing A5 237 communication._.
R emember to zet the aperture - source
diztance before you start acquinng data.
5. If RS-232 communication is established, the program will

start after a few more moments. The main window will
appear with the Rectangular View window and the Beam
Statistics windows open, as shown below. The system
will be in the Single Scan Mode.

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 43



Goniometric Radiometer - sample_gdf [_ O[]

EE e I PRI |- [o [ ~

1
;- Rectangular View - Photon inc. 9 =] Bl B Beam Statistics 0 samples - Photon Inc. [_ (O] x]

y =] sAleln » |m e ] w2l
Pararneter ‘ Walue ‘ Mean | bdin | b e | Sitel Devl

Amplitude {Relative units) Phi = 0.000° —
1.0 50.0% Angularidth at 0.0° (deg)

Angular Centroid at0.0° (deg)
Angular Peak at0.0° (deg)

-90" 80" 70 60 50 40 -30 20 -10 0 10 20 30 40 50 60 70 80 90
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For Help, press F1

6. If RS-232 communication is not established, the following
message will appear after approximately 30 seconds. In
this case, click “OK”, then check that the RS-232 cable is
securely connected, verify the COM port connection, and
ensure the Goniometric Radiometer is powered on. Then
go back to step 3 above. If the problem persists, contact
Spiricon.

Goniometric Radiometer |

Q Mo communication with Goniometric B adiometer. Program aborted.

7. Set the Aperture-Source Distance in the Aperture-Source
Distance dialog box accessed under the Data Collection
Menu.
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Data Collection

Acguire Scan Data
Scan Mode

Chrl+

Acquire A0 Data
A0 Azimuth Scanz...
FReplay 30 Data...

Computed Crozs Sections...

Senzitiviby. .

Aperture-Source Diztance. ..

Pulzed Mode...
Ehi...

Beference Fower...
Units

Auta Gain
v Blind Spot Corection
Recompute

Chrl+&,

Chrl+FR

Aperture-Source Distance

Aperture-zource distance [cm) ; IEI

Cancel |

8. Turn on data acquisition by selecting Acquire Scan Data
under the Data Collection Menu, or by clicking the left

mouse button on the Data Collection icon

on the main toolbar.

’ located

9. Set the Scan Amplifier gain in the Sensitivity Dialog box,
accessed under the Data Collection Menu. Make sure
your Device Under Test is powered on.

— Averaging

) W edium

Gain[dB} [0

Cancel |

R

E stimated Time:

Single Mode:

Perpendicular Mode: I

10. Increase the gain setting until you observe a signal in the
Rectangular View window. Continue increasing the gain
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until just below saturation to achieve the best vertical
resolution.

11. The values for the 50% angular width, the Peak angle
and the Centroid angle will be displayed in the Beam
Statistics window. You are now acquiring data at the
default azimuth scan angle of 0°. It's that simple.

6.2. Advanced Use

The previous Quick-Start procedure utilizes only the very basic features of
the Goniometric Radiometer software program. The program is very
powerful and flexible, allowing users to configure the analyses and the
information display windows to suit their individual needs. Users can arrange
and size multiple windows as required, and these screens can be saved as
files for future use. Also, data can be exported to spreadsheets, math and
statistical analysis programs, and process/instrumentation programs by
logging data to files or COM ports, or shared using ActiveX.

At this point, take a few minutes to read the rest of this section, which
includes detailed descriptions of the software features that control the
various scanning modes and ways to analyze, display and log data. The
software is also described in the On-line Help. A little time spent in advance
learning the features of the system will go a long way in making the
Goniometric Radiometer an invaluable resource for far field source
characterization.
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6.3. Scan Modes

There are 3 scan modes for data acquisition. The 3 scan modes are:
1. Single Axis Mode,
2. Perpendicular Axes Mode, and
3. 3D Mode

The Scan Mode is selected under the Data Collection Menu, or by clicking
the tool bar icons:

I Selects the Single Axis Scan Mode
—L Selects the Perpendicular Axes Scan Mode

’31?' Selects the 3D Scan Mode

The Single Axis and Perpendicular Axes Modes provide the most rapid
characterization of a source. The 3D Mode takes more time but provides the
most complete characterization.

6.3.1. Single Axis Mode

In the Single Axis Mode, the system performs scans along 1 azimuth angle.
The angle of the scan can be set using the Phi Angle dialog box. This dialog
is accessed under the Data Collection Menu by selecting “Phi...” Offset
angles ranging from 0 to 180° in increments of 0.225° can be selected from
the list in the Dialog box. The default Phi angle is 0°.

6.3.2. Perpendicular Axes Mode

In the perpendicular axes mode, the system performs two scans in
orthogonal directions. The first scan is made at the angle set in the PHI
Angle dialog box. The second scan is made at this angle plus 90°.

6.3.3. 3D Scan Mode

In the 3D mode, a series of measurements are made at incremental azimuth
(Phi) angles ranging from 0° to 180°. The incremental angles available are
18°, 9°, 3.6°, 1.8° and 0.9°. Respectively, the number of scans made for
these 3D measurements are 10, 20, 50, 100, and 200.
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6.4. Viewing Data

The acquired data can be viewed in various ways using the different
windows. The windows are:

Rectangular View;

Polar View;

Beam Statistics;

Time Statistics (up to 15 can be opened);
3D Rectangular View;

3D Polar View;

Topographic View;

8. Power View.

No gk~ wNPRE

Data acquired in the Single Axis and Perpendicular Axes Modes can be
displayed in the following Windows:

Rectangular View The Rectangular View window displays a graph
of amplitude or intensity vs. scan angle in
Cartesian coordinates of the data sets acquired
for either one or both scans.

Polar View The Polar View window displays a graph of
amplitude or intensity vs. scan angle in polar
coordinates of the data sets acquired for either
one or both scans.

Beam Statistics The Beam Statistics window displays numerical
values of parameters obtained from the scan
data. The parameters are angular beam width,
numerical aperture, angular beam width ratios,
centroid angle, peak angle, centroid amplitude,
peak amplitude, amplitude at user specified
angles. It also displays the Mean, Minimum,
Maximum, and Standard Deviation values, and
the Maximum Limit and the Minimum Limit for
parameter limit testing.

Time Statistics The Time Statistics windows are displays of
parameter values versus the sample number.
Up to 15 Time Statistics windows can be
opened.
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Data Acquired in 3D Mode can be displayed in the following windows:

3D Rectangular View The 3D Rectangular View window displays a
representation of the source profile in
cylindrical coordinates, with the data as the

height or “z” value, above the (6, ¢) plane. The
view perspective is looking toward the source.

3D Polar View The 3D Polar View window displays the data in
spherical coordinates, with the data as the
radius from the origin. The perspective of this
view is looking toward the source.

Topographic View The Topographic View window displays the
relative amplitude of the data acquired in a 3D
scan in a false-color format on a polar grid of &
and ¢. The perspective of this view is looking
from the source.

Rectangular View The Rectangular View window is used to
display data after a 3D acquisition. Select the
Replay Mode or the Centroid Replay Mode
from the Data Collection Menu, or click the
Replay or Centroid Replay icon.

Polar View The Polar View window is used to display data
after a 3D acquisition. Select the Replay Mode
or the Centroid Replay Mode from the Data
Collection Menu, or click the Replay or
Centroid Replay icon.

Power The Power window displays a graph of the
cumulative angular power, numerical values
(up to 3) of the power within specified cone
angles, numerical values (up to 3) of the cone
angles containing specified percentages of the
total power, and the 6 and ¢ values of the
angular 3D centroid of the profile. The
cumulative power graph and associated
parameters are determined along either the
instrument optical axis or the 3D centroid axis.

6.5. Pull-Down Menus
6.5.1. File Menu

The “File” Menu is used for opening and closing files, saving files, setting
preferences at program startup, and for printing. When “File” on the Menu
Bar is clicked, the pull-down menu below appears:
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New

Open...

Close

Save

Save As...

*.GRD

*.CFG

Hew Chrl+M
Open... Chrl+0
Cloze

Save Chrl+5
Save bz

Preferences r
Frirt... Chrl+F
Frirt Setup. ..
EecentkEle

Exit

Halts data collection, closes all open windows,
and then opens a new file with the
Rectangular View window displayed.

Opens the File Open dialog box. It lists Data
Files from the current working directory. To
open a data file, select one from the list and
then select the Open button. All windows will
be closed and the new file will be loaded. The
data, windows and computed statistics from the
file will be displayed.

Halts data collection and closes all open
windows.

Saves the current data and windows
configuration in the currently active folder. The
name of this file is displayed on the main
window title bar.

Opens the File Save As dialog box. It lists Data
Files from the current working directory. Either
select an existing file from the list or enter a new
name in the File Name edit box. To save as a
data file, simply select the Save button.
Otherwise, select the desired file type from the
Save As Type combo box. There are 5 different
file types, identified by their extensions:

Goniometric Radiometer Acquisition and
Analysis Program Data File. This file can only
be used by the Goniometric Radiometer
software. The configuration of the screens,
system settings, and the beam measurements
(data) are saved.

Configuration File. This file can only be used by
the Goniometric Radiometer software. The
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*PRW

*ASC

*BMP

Preferences

configuration of the screens and the system
settings are saved.

3D Data File. This file is in binary format and
contains data from the last 3D Acquisition. It is
provided for users to perform custom off-line
analysis using their own code. This file type
cannot be imported back into the Goniometric
Radiometer Software. The structure of the file is:

number of scans, stored as unsigned short
type (2 bytes);

number of points, stored as unsigned short
type (2 bytes);

Theta Angles: “number of points” values stored
in radians, as float type (4 bytes).

Data: “number of scans x number of points”
values, stored as short type (2 bytes). Data are
stored scan after scan (each scan has “number
of points” values corresponding to the Theta
Angles). The value of the Phi Angle (deg) is
180° / (number of scans) x (number of current
scan - 1).

ASCII File. The file contains profile data and
the data from each view in ASCII format.

Bitmap File. Saves the program screen as a
Bitmap File.

Configures user preferences on startup and
exit.

Freferences Timed Backup...
On Power Up r
O Exit r
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Timed Backup...

On Power Up

Load Previous
Setup

Global Collect On
Background Logo

On Exit

Save Setup

Prompt

Print...

Opens the Automatic Data Backup dialog box,
for configuring if and when backups are to occur.
If the Backup On checkbox is selected, then all
data will be saved automatically at the specified
interval. Use this feature when collecting data
over extended periods to prevent data loss in the
event of a power outage or other catastrophe.
When the program is restarted after such an
event, the backup file wil load and data
collection will resume from the point of the last
automatic save.

Automatic Data Backup E

¥ Backup On

B ackup Interal
=
|1D = minutes
Cancel |

Opens a menu with the following selections:

O Power Up ] Load Previous Setup
Global Collect On
Background Logo

When checked, the last saved data file will
automatically load at startup.

When checked, data collection resumes at
startup.

When checked, the Photon Logo appears as
the background for the main window.

Opens a menu with the following selections:

Save Seti

Prampt

When checked, the user is prompted to save
the latest data as a .GRD or configure as a
.CFG file upon exit.

When checked, the user is prompted with the
message “Leaving Already?” upon exit.

Opens the Print dialog box, used for printing
the program screen.
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Print Setup... Opens a dialog box for selecting and
configuring printers.

Exit Exits the program.

6.5.2. Edit Menu

When “Edit” on the Menu Bar is clicked, the pull-down menu below

appears:
Copy Chrl+C |

Copy Copies the active window to the Windows
clipboard as a bitmap image. From there, the
bitmap can be pasted into other program
applications.

6.5.3. View Menu

When “View” on the Menu Bar is clicked, the pull-down menu below
appears:

v tain Toolbar
v Local Toolbar

v Statuz Bar
Main Toolbar When checked, the toolbar on the main window
is visible.
Local Toolbar When checked, the toolbar of the currently
active view is visible, if available.
Status Bar When checked, the status bar at the bottom of

the main window is visible.

6.5.4. Options Menu

Various options associated with the window views can be selected under the
“Options” menu when that particular window is active. The list of options
are unique for each window type. The options list can be found under the
window descriptions.

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 53



6.5.5. Data Collection Menu

The “Data Collection” menu includes selections, which determine or affect
the collection of data. When “Data Collection” on the Menu Bar is clicked,
the pull-down menu below appears:

Acquire Scan Data

Scan Mode

Acquire 3D Data

3D Azimuth Scans...

Drata Collection

Acguire Scan Data Clrl+(
Scan Mode 3

Acquire 30 Data

3D Azimuth Scans...
Replay 30 Data...
Computed Crogz Sections. ..

Senzitivity. ..

Aperture-Source Distance...

Pulzed Mode. ..

Ehi...

Beference Power...

Unitg 3

Auto Gain Clrl+
v Blind Spot Carrection
Fecompute Ctrl+F

Turns data acquisition on or off when operating
in either Single Axis or Perpendicular Axes
scan modes.

Selects either the Single Axis or Perpendicular
Axes Scan Modes.
Scan Mode *  Single Axiz
Perpendicular Axes

Starts 3D data acquisition.

Opens a dialog for selecting the number of
azimuthal scans for a 3D acquisition, either 10,
20, 50, 100 or 200. The corresponding angular
increments are 18°, 9°, 3.6°, 1.8° and 0.9°.

3D Azimuth Scans

Murnber of scans
[degres |1D [18.07) 'I
incremert] Earze] |
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Replay 3D Data... Turns on the Replay Mode, where data
acquired in the last 3D scan can be viewed in
either the Rectangular View, Polar View or
Beam Statistics window. The azimuth angle of
the scan is selected in the combo box. To exit
the Replay mode, press the Cancel button.

Replay

Display Dataat 0000 -]

Computed Cross Turns on the Computed Cross Sections Replay

Sections... Mode. In this mode, orthogonal cross sections
computed using the scan data obtained from
the last 3D acquisition are displayed in either
the Rectangular View or Polar View. The
parameters for the computed cross sections
are displayed in the Beam Statistics window.
The computed cross sections can be through
either the 3D Centroid, the 3D Peak, or through
an Arbitrary Vector. This selection is made in
the Computed Cross Sections dialog which
appears after selecting the Computed Cross
Sections Replay Mode. The offset azimuth
angle of the first computed cross section is
entered in the edit box. For offset “0”, the
computed orthogonal cross sections are in the
directions of the major and minor axes of the
Centroid intensity distribution. To exit the
Computed Cross Sections Replay Mode, press
the Close button.

Computed Cross Sections [ x|
Reference Direction
" 3D Centroid
" 3D Peak

" 3D User Defined  Theta [deq); ID Phi [deg] : ID
DOffzet from b ajor/Minor Axes [deg) ID
Cloze |
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Sensitivity... Opens the Sensitivity Dialog Box. This dialog
box is used to manually set the Gain, Filter and
Average settings for data presentation. The
gain can be set over the range from O to 139
dB for InGaAs detectors and from O to 159 dB
for Silicon detectors. The filter value sets the
number of points used in a consecutive sum
smoothing filter used in data analysis and
display. Values from 0 to 99 are allowed. The
Averaging Value sets the number of scans to
be averaged together before analysis and
displays. User selected values can range from
1 to 10,000. The Low, Medium and High
selections are not presently available and are

inactive.
Senszitivity |
Gan(@Br ° =
- Cancel
Filter: I-I =i il
— Averaging
& Usger |1 _I? E stimated Tirne:
) Loy I Single Mode: I
) Medim I Perpendicular tode: I
) Hiah I
Aperture-Source Opens the Aperture-Source Distance Dialog
Distance... Box. This dialog box is used to enter the value

of the Aperture-Source Distance, i.e. distance
between the datum plane of the entrance
aperture and your source. The value is in
centimeters (cm). Resetting the value of the
Aperture-Source Distance will reset/void all
previously acquired data. A dialog box alerts
the user to this impending action.

Aperture-Source Distance

Aperture-zource distance [om) ID—
Cancel |
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Pulsed Mode...

Phi...

Reference Power...

Opens the Pulsed Mode Dialog Box. If you are
using a pulsed source, use this dialog box to
set the Pulsed Mode of operation and to enter
the pulse repetition frequency of the source.
When operating in Pulsed Mode, the peaks of
the individual pulses in the profile are
connected to form a smooth profile. All
parameter computations will be performed on
the resulting smooth profile. The allowable
frequency range is 0.1 — 20 kHz.

Pulzed Mode E3

¥ Pulzed Mode K

Source Frequency [kHz]: |'| Cancel |

Opens the Phi Angle Dialog Box. This dialog
box is used to select an offset Azimuth Scan
Angle for Single Axis and Perpendicular Axes
Scan modes. When operating in the Single
Scan mode, the scan will be performed at the
selected Phi angle. In Perpendicular Axes
mode, the first scan will be made at this angle
and the second scan will be made at Phi + 90°.
The values available for selection range from
0° to 80° in 0.225° increments.

Phi Angle Ed

Fhi[deg] |0.000 >

Cancel |

Opens the Reference Power dialog box. Enter
the value of the measured reference power in
the edit box and select the units—uW, mW or
W, in the combo box.

Reference Power |
E;::éﬁme I'I itz | e -
Cancel |
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Units Opens the Units submenu for selecting the
units for the Rectangular View, Polar View,
Beam Parameters, and Time Statistics
windows. Choices available are Relative (%),
0-100%, Counts, 0-255, or Intensity (W/sr). The
Intensity (W/sr) selection is only available if a
3D acquisition has been performed.

TS Fciive ()

Counts
Intenzity Mz

Auto Gain Automatically sets the amplifier gain when
operating in either Single Axis Scan Mode or
Perpendicular Axes Scan Mode.

Blind Spot Correction Turns Blind Spot Correction on or off.

Recompute Use Recompute to reanalyze acquired scan
data or computed cross section data for either
the previous acquisition or for saved data files.

6.5.6. Window Menu

When “Window” on the Menu Bar is clicked, the pull-down menu below
appears:

Window

Hew window r

LCazcade
Tile
Arrange lconz

Claze All

v 1 Rectangular Yfiew - Photon inc.

The Window menu is used to open new
windows, to arrange windows and window
icons and to close all open windows. The list at
the bottom of the menu shows which windows
are open with the currently active window
checked.
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New Window Opens a submenu for opening windows
available for viewing.

Bectangular Yisw F2
Eolar Yiew F3

30 Polar Yiew F4
3D Rectangular Yiew Fh
Topoaraphic: Yigw FE

Beam Statistics F7
Time Statistics Fg
Power F9
Hotes Fi2

6.5.7. Help Menu

Use the “Help Menu” to access Help Topics, directions on how to use the
On-line Help, and Goniometric Radiometer software version information.

Help
Help Topicz
Uzing Help

About Goniometric B adiormeter...

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 59



6.6. Window Descriptions

6.6.1. Rectangular View

Open the Rectangular View window. This window displays the data from
either a single axis scan or perpendicular axes scans with measured
amplitude vs. angle in rectangular coordinates. Options for this menu are
accessed through the Options menu when the Rectangular View window is

active.

= Rectangular Yiew - Photon inc.

, | w | A

Phi = 0.000°

nmplltude (Relative units)
r‘l. N\
4
LI
h
Y
|I"l.
/ \I

Phi = 90.000*

Amplltude {Relatme umts}
1.0
. IH '|
[
) |II II
|II I'
. Ifl \
f
K |
,-"I Y
-y -0 S50 -40° -30° 200 -10° L 1 07 90

-90° -&0°
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The Options Menu available when the Rectangular View window is active is
shown below. The selections are:

Data Collection

Timing...

Zoom Angle...

Normalize

|:_| u} til:l [k
Data Collection  Crl+Dr
Timing...

Zoom Angle...
Marrmalize

Colors...

Turns data collection on and off.

Opens a dialog box for selection of the profile
update rate.

Timing |

Plat Frequency

|5 ILIpdatesfSeu: j

Cancel |

Opens the Zoom Angle Dialog Box. The Zoom
Angle Dialog box allows zooming to view a
section of the scan data in greater detall. It is
used to select the Angular Range, the Zoom
Offset Angle and the Grid Spacing. All values
are in degrees.

Zoom Angle E2 |

Zoom Range [7]; |13|:I

Zoom Offzet [7]: I Cancel |
Zoorm Grid [7] : I'IEI I

Scales the profile amplitude to have a peak
value of 1, i.e. full scale. (In Perpendicular
Axes Scan mode the normalization will be for
the largest amplitude scan).
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Colors... Opens a Colors dialog box, used for selecting
the color scheme for the displayed graph.
Colors for the background, text, grid and data
can be independently set. To change a color,
click on the appropriate color “button” to open
a Windows color selection dialog box.

N

B ackground |
T ext color o .
Gnid colar | ﬂl
D ata -

Some of the options can also be selected using the icons on the
Rectangular View window toolbar:

b Starts Data Collection

[ Stops Data Acquisition

W Normalize the Display

o) Opens the Zoom Angle Dialog Box

11 Opens the Color Selection Dialog Box
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6.6.2. Polar View

Open the Polar View window. This window displays the data from either a
single axis scan or perpendicular axes scans with measured amplitude vs.
angle in polar coordinates.

. Polar Yiew - Photon Inc.

Phi = 0.000°

1.0 oG LLH 0.4 R R - A .G
Amplitude (Relative units) . o . Phi = 90.000*

The Options Menu available when the Polar View window is active is
shown below. The selections are:

Dptions
Data Collection Ctrl+D
Timing...

Zoom Angle...
Hormalize

Colors...
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Data Collection Turns data collection on and off.

Timing... Opens a dialog box for selection of the profile
update rate.
Timing |

Flot Frequency

|5 ILIpu:Iatesx'Sec: j
Cancel |
Zoom Angle... Opens the Zoom Angle Dialog Box. The

Zoom Angle Dialog box is used to select the
Angular Range, the Zoom Offset Angle and
the Grid Spacing. All values are in degrees.

Zoom Angle [ x| |

Zoom Fange [*]: |1EEI

Zoom Offget [7] I Cancel |
Zoom Gid [*]: I'ID I

Normalize Scales the profile amplitude to have a peak
value of 1, i.e. full scale. (In Perpendicular
Axes Scan mode the normalization will be for
the largest amplitude scan).

Colors... Opens a Colors dialog box, used for selecting
the color scheme for the displayed graph.
Colors for the background, text, grid and data
can be independently set. To change a color,
click on the appropriate color “button” to open
a Windows color selection dialog box.

Colors
B ackground |
Text color |
Grid calar | ﬂl
[rata I
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Some of the options can also be selected using the icons on the
Rectangular View window toolbar:

> Starts Data Collection

n Stops Data Acquisition

[ | Normalize the Display

&L Opens the Zoom Angle Dialog Box
i1 Opens the Color Dialog Box

6.6.3. 3D Polar View

Open the 3D Polar View window. This window displays data from 3D
acquisitions in a “3-dimensional” viewing format in spherical coordinates.
The image can be rendered with either a wireframe or solid surface. The
view perspective is looking toward the source.

|4 3D Polar View - Photon inc.

4

(@ |> R |~ B> |[x]

Rotx Roty Zoom

The Options Menu available when the Polar View window is active is
shown below. The selections are:

Options

v Solid Surface

Clip Lewvel ..
v Clip Legend

Bezolution 3
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Solid Surface When selected, the image will have a solid
surface. When not selected, the image will be
rendered as wireframe.

Clip Level... Not presently available.
Clip Legend Not presently available.
Resolution Opens a submenu for selecting the resolution

of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

Beszalution (LRl
M edium
High

The toolbar at the right border of the window contains 8 buttons used to
select several viewing and image manipulation features. These buttons
are, from top to bottom:

k Chooses the “Arrow” cursor. Allows image
S manipulation only using the mouse and the
thumbwheel controls.

@ Chooses the “Hand” cursor. Allows image

manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window
border the Hand cursor changes to the Arrow
cursor.)

This Help menu is inactive. Please use the
main Help menu.

Resets the view to a preset “Home” default
position, size and orientation.

Sets the default settings for the “Home”
button.

Restores the view to include the entire image.

B = 2 =

Activates the “Seek” cursor. After positioning
this cursor on a selected point in the image
and clicking the left mouse button, a close-up
zoom to that point will be performed
automatically. Also, the center of rotation will
be set to that point.
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@ @I Toggles between the Orthographic and

Perspective projection modes.

There are also several “thumbwheels” along
NI
I — the window border, designated “Zoom”,

“Dolly”, “Rotx”, and “Roty”, which are used to
zoom and rotate the 3D image.

The image can be rotated, translated, panned, and zoomed using the
mouse with the Arrow cursor and the “thumbwheel” control knobs or using
the mouse with the Hand cursor, as described below.

Rotation Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
ROTX and ROTY. Alternatively, use the
mouse and the Hand cursor to directly rotate
the image; Position the hand cursor over the
image, depress the left mouse button, and
drag the mouse to obtain the desired
orientation.

Pan/Translate While depressing the control key <CTRL>,
use the mouse and the Hand cursor to directly
pan the image. Position the hand cursor over
the image, depress the left mouse button,
depress the control key, and drag the mouse
to move the image to the desired location.

Zoom The method for zooming the image depends
on the type of display projection selected. In
the Perspective projection mode, use either
the zoom control arrows at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window.
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6.6.4. 3D Rectangular View

Open the 3D Rectangular View window. The 3D Rectangular View window
displays the source intensity pattern in a “3-dimensional” viewing format in
cylindrical coordinates. The image can be rendered with either a wireframe
or solid surface, with user selected clip levels and colors. The perspective of
this view is looking toward the source.

|.# 3D Rectangular Yiew - Photon inc.

Lelha CACARNE Rl

ClipLevels(%5)

Rotx Roty Mo Zoom

The Options Menu available when the 3D Rectangular View window is
active is shown below. The selections are:

Options

v Solid Surface

Clip Lewvel ...
v Clip Legend

Bezalution 3

Solid Surface When selected, the image will have a solid
surface. When not selected, the image will be
rendered as wireframe.
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Clip Level... Opens a dialog box for selecting clip level
contours and their colors.

ClipLevels for 3D Plots [ x|

Color  Clip Lewel

100.0% 21 ClipLevel
90.0%
75.0%
60.7%

50.0% o
368% = O

add | Delete |
Clip Legend When selected, the clip level legend will be

displayed in the 3D window.

Resolution Opens a submenu for selecting the resolution
of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

Besolution  » RN R
I edium
High

The toolbar at the right border of the window contains 8 buttons used to
select several viewing and image manipulation features. These buttons
are, from top to bottom:

k Chooses the “Arrow” cursor. Allows image
— manipulation only using the mouse and the
thumbwheel controls.

@ Chooses the “Hand” cursor. Allows image

manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window
border the Hand cursor changes to the Arrow
cursor.)

9 This Help menu is inactive. Please use the
e main Help menu.

£) Resets the view to a preset “Home” default
— position, size and orientation.
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Sets the default settings for the “Home”
button.

Restores the view to include the entire image.

%

Activates the “Seek” cursor. After positioning
this cursor on a selected point in the image
and clicking the left mouse button, a close-up
zoom to that point will be performed
automatically. Also, the center of rotation will
be set to that point.

@ @l Toggles between the Orthographic and

Perspective projection modes.

i

There are also several “thumbwheels” along
IR
I — the window border, designated “Zoom”,

“Dolly”, “Rotx”, and “Roty”, which are used to
zoom and rotate the 3D image.

The image can be rotated, translated, panned, and zoomed using the
mouse with the Arrow cursor and the “thumbwheel” control knobs or using
the mouse with the Hand cursor, as described below.

Rotation Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
Rotx and Roty. Alternatively, use the mouse
and the Hand cursor to directly rotate the
image; Position the hand cursor over the
image, depress the left mouse button, and
drag the mouse to obtain the desired
orientation.

Pan/Translate While depressing the control key <CTRL>,
use the mouse and the Hand cursor to directly
pan the image. Position the hand cursor over
the image, depress the left mouse button,
depress the control key, and drag the mouse
to move the image to the desired location.

Zoom The method for zooming the image depends
on the type of display projection selected. In
the Perspective projection mode, use either
the zoom control arrows at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window.
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6.6.5. Topographic View

Open the Topographic View window. This window displays the data from 3D
acquisitions with false color in polar coordinates. The perspective of this
view is looking from the source.

|4 Topographic View - Photon inc.

5.0

ClipLevels{%a)

The Options Menu available when the Topographic View window is active
is shown below. The selections are:

Options

Clip Level ..
v Clip Legend

Besolution ¥

Clip Level... Opens a dialog box for selecting clip level
contours and their colors.

ClipLevels for 2D Plot [ x|

Caolor  Clip Lewel

100.0% 21 ClipLevel
90.0% S
75.0%

=

60.7%

50.0% o
36.8% e

Add | Delete |
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Clip Legend When selected, the clip level legend will be
displayed in the 3D window.

Resolution Opens a submenu for selecting the resolution
of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

Beszalution (sl
I edium
High
Zoom To Zoom in, click and hold down the left

mouse button while dragging the mouse away
from the center. To Zoom out, click and hold
down the left mouse button while dragging the
mouse toward the center. To translate up,
down, left and right, simultaneously press the
Ctrl key and the Left Mouse Button, and drag
the mouse to move the image to the desired
location.
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6.6.6. Beam Statistics

Open the Beam Statistics window. This window displays a tabular
summary of beam parameters and statistics. It is also used for Limit
Analysis. The parameters for viewing are selected in the Beam Statistics
Parameters dialog box.

B Beam Statistics 14 samples - Photon Inc. M=l E3
T Lalx]

FParameter | Walue | kean | ki | b & | Std Dy | bty Linnit | b & Lirnit |
O 5.0% Angular Width at 0.0° [deg] a1 FAEd F4Y ¥4 1.0 o a0.0
O 5.0% Angular Width at 90.0° [deg) 234 2345 232 238 020 15.0 25.0
‘ 13.5% Angular width at 0.0° [deg) a2 310 BYY  BBE 025 B0.0 a0.0
‘ 13.5% Angular Width at 30.0° [deg] 191 1318 130 134 012 12.0 12.0
O B0.0% Angular wWidth at 0.0° [deg) 04 3032 300 05 014 250 350
O B0.0% Angular \Width at 30.0° [deg] 108 1084 108 109 005 0.0 200
O 20.0% Angular wWidth at 0.0° [deg) 158 1875 165 160 012 12.0 12.0
‘ 20.0% Angular \Width at 30.0° [deg] 58 RB0 &7 53 0.04 a.0 10,0
‘ A0.0% Angular wWidth at 0.0° [deg) .0 =RE]| 2.9 102 050 0.0 15.0
‘ A0.0% Angular \Width at 30.0° [deg] 32 326 32 33 0.0z 20
‘.-’-‘-.ngle Ratio at 5.0 2 Width 322 3226 36 334 0067 0.30 110
‘.-’-‘-.ngle Ratio at 13.5 % Width 04 3020 293 303 0029 5.00
O.-’-‘-.ngle Ratio at 50,0 % Width 28 2796 276 283 0023 1250
O.-’-‘-.ngle Fatio at 80.0 % Width 272 207 2ea 273 0027 0.00 200
‘.-’-‘-.ngle Ratio at 90.0 % Width 278 2BRE 2Va4 314 0147 1.00 250
O.-‘l'-.ngular Centroid at 0.0° [deq] 0o 0o 00 01 003 B0 5.0
O.-‘l'-.ngular Centraid at 90.0° [deq] n.a nas 07 1.0 01z 2.0 20
Oﬁngular Peak at 0.0° [deg) n3 nos 07 ns 0.49 1.0 20
‘ﬁngular Peak. at 90.0° [deg] 1.1 117 1.0 1.4 01z 1.0 ns
O Centroid Amplitude at 0.0% [a.u.] 08s 0B854 084 085 0007 075 090
‘ Centroid Amplitude at 90.0° [a.u.] nes 0B85 085 086 0003 075 nses
O Peak Amplitude at 0.0° [a.u.] nes 0878 087 083 0002 095
‘ Peak Amplitude at 90.0° [a.u.] nes 0888 083 083 Q0002 0.90
O.-’-‘«mplitude for Theta=-5.0° &t 00° [auw] 075 0750 074 06 (0006 0.50
‘.-’-‘«mplitude for Theta =-5.0° &t 90.0° [au] 040 0400 038 042 003 0.50
O.ﬁ.mplitude for Theta=5.0° at 0.0° [aw] 081 neld 080 082 0003 060 050
O.ﬁ.mplitude for Theta=5.0"at90.0° [aw] 0OBF 0530 0B85 0B0 QO6 0.50 07s

Limit Analysis

Limit analysis can be performed on any of the parameters reported in the
Beam Statistics window. The parameters are checked against user
specified maximum and/or minimum values and the result of the analysis is
displayed using icons in the Beam Statistics window, as shown above. To
configure the analysis, either double click with the left mouse button on the
desired parameter, or, alternatively, use the Up/Down Arrow keys to
highlight the parameter and then press the Space key. This will open the
following dialog box for setting the parameter limits for the analysis.
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13.5% Angular Width at 0.0 [deg] EH

¥ Minirmum ' alue: Ih':' Ok I
IV b amirniurn ' alue: |2|:| T |

Either one or both limits can be set. The icons for reporting the analysis are:

O Parameter value is within the set limit or
limits.

F Parameter value is greater than the maximum
limit.

v Parameter value is less than the minimum
limit.

The Options Menu available when the Beam Statistics window is active is
shown below. The selections are:

Options

Data Collection Ctrl+D
Timing...
Rezet
Parameters. ..
Eont...
Log Chrl+L
Data Collection Turns data collection on and off.
Timing... Opens a dialog box for selection of the
window update rate.
Timing |

Plat Frequency

|5 ILIpu:Iatesx'Seu: j
Cancel |
Reset Resets the values on the Beam Statistics

window.
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Parameters... Opens the Beam Statistics Parameters
dialog box.
Beam Statistics Parameters |
—&ngular Width / Humernical Aperture [~ Statistics g
v B v B ™ Continuous
v 135 ¥ 135 ™ Raling I-m Cancel |
W 500% ¥ 500% & Fi W
v Users 80 v Users * Finite
W Useri |30 ¥ Userz — Dizplay
¥ Walue
—&ngular Width Fatio V| Mean
v B2 I bin
v 135 W hax
W osnoz ¥ 5tdDev
Iv Userz |30 W in Limit
¥ Users |30 W b= Limit
— &ngular Position ~ Logging
¥ Centroid Output " MNone
v Pealk = File |[log
" Part IEEIM1: vI
— Armnplitude - =
¥ Centraid - Drelirmiter: I arnma "I
¥ Peak _ v Date
¥ Uszer &ngle(deg) 0 7 T"""_E
¥ User Anglefdeg) |-G ¥ Serial Number: I':'E"I

Selection choices in the Beam Statistics Parameters Dialog box are:

Angular Width
5%
13.5%

50%

User %

User %

Numerical Aperture

5%

13.5%

Angular width at the 5% clip level (% of peak).

Angular width at the 13.5% clip level (% of
peak).

Angular width at the 50% clip level (% of
peak).

Angular width at the user specified clip level
%.

Angular width at the user specified clip level
%.

Numerical aperture at the 5% clip level (% of
peak).

Numerical aperture at the 13.5% clip level (%
of peak).
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50% Numerical aperture at the 50% clip level (% of

peak).

User % Numerical aperture at a user specified clip level
%.

User % Numerical aperture at a user specified clip level

%.

Angular Width Ratio In Perpendicular Axes Scan Mode, the ratio of
the angular width at angle ¢ to the angular
width at angle ¢+ 90°.

5% Angular width ratio at the 5% clip level (% of
peak).

13.5% Angular width ratio at the 13.5% clip level (%
of peak).

50% Angular width ratio at the 50% clip level (% of
peak).

User % Angular width ratio at the user specified clip

level (% of peak).

User % Angular width ratio at the user specified clip
level (% of peak).

Angular Position

Centroid Value of the angular scan first moment
Peak Angular value of the peak.
Amplitude
Centroid Signal amplitude at the centered.
Peak Signal amplitude at the peak.

User Angle(deg) Signal amplitude at the user specified scan
angle. The angle range is [-90°, 90°].

User Angle(deg) Signal amplitude at the user specified scan
angle. The angle range is [-90°, 90°].

Statistics
Continuous Selects a continuous average of data
samples.
Rolling Selects a rolling average with user specified

number of samples.
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Finite Selects a finite average with user specified
number of samples.

Value Selects display of the present value of the
beam parameter.
Mean Selects display of the mean value of the beam
parameter.
Min Selects display of the minimum value of the
beam parameter.
Max Selects display of the maximum value of the
beam parameter.
Std Dev Selects display of the standard deviation of
the beam parameter.
Min Limit Selects display of the minimum limit value of
the beam parameter set in Limit Analysis.
Max Limit Selects display of the maximum limit value of
the beam parameter set in Limit Analysis
Logging
Output
Delimiter Selects the delimiter format for the logged
data.
None No data logging.
File Data logging to specified file.
Port Data logging to serial port COM1 or COM2.
Date If selected, the date is attached to the logged
file.
Time If selected, the time is attached to the logged
file.
Serial No. If selected, the specified serial number is
attached to the logged file.
Font... Opens the Font Selection dialog box. This

allows the user to change the font of the text
in the Beam Statistics window.

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 77



Log If data logging is enabled, one additional set
of data is acquired and then displayed and/or
logged to the file. If data collection is disabled
for the Beam Statistics window, it allows the
user to take individual data one set at a time
and log it to a file. The Hot Key “Ctrl+L”
enables logging even if another window is
active as long as the Beam Statistics is open.

Some of the options can also be selected using the icons on the Beam
Statistics View window toolbar:

> Starts Data Collection.

[ Stops Data Acquisition.

x Clears and Resets the Beam Statistics
Window.

% Opens the Beam Statistics Parameter Dialog
Box.

6.6.7. Time Statistics

Open the Time Statistics window. The Time Statistics window displays strip
charts of beam parameters versus sample number or time. Any or all of the
computed beam parameters may be viewed in this way. Up to 15 Time
Statistics windows can be opened. Several overlays are available in the
options menu, including grids, statistical markers, and numerical statistical
summaries.

@ Time Statistics for Angular Width - Photon Inc.

,La [ FEFe o]

3o

20

10

10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200
Points

50.0% Angular Width at 90.0° {deg)|

50.0% Angular Yidth at 0.0° (deg)

Variahle Mean Min Max StdDev
50.0% Angular Width a 30.32 30.17 30.39 0.0480
50.0% Angular Width a 10.82 10.69 1091 0.0427
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The Options Menu available when the Time Statistics window is active is
shown below. The selections are:

Data Collection

Timing...

Options
Data Collection Chrl+D
Timinog...

Rezet Graph
v Grid On
kean
Minbd am
Standard Deviation
Show Calculations

Eont...
Parameters. ..
Ames..,

Turns data collection on and off.

Opens a dialog box for selection of the
window update rate.

Time Stat Timing |

R ate

— Autornatic 0 ata Callection

Uritz Diwration kit

|5

ill ILIpdatesHSec: j |1|:":":| j IF'n:nints j

— Manual Data Collection

[ Marual  [1000 =

MHumber of Points

=

Cancel |

Reset Graph
Grid On

Mean

Min/Max

Standard Deviation

Resets the chart.
Turns the grid overlay On or Off.

Displays an overlay on the chart at the mean
value.

Displays overlays on the chart at the minimum
and maximum values.

Displays overlays on the chart at the standard
deviation value.
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Show Calculation Turns the Statistics Calculation Overlay Text
On or Off. The overlay, displayed at the
bottom of the chart, shows the values for
mean, minimum, maximum and standard
deviation.

Font... Opens the Font dialog box. This allows the
user to change the font of the text in the Time
Statistics window.

Parameters... Opens the Time Statistics Parameters dialog
box for selecting chart parameters and the
color of the graph.

Parameters E |

I.ﬁ.ngular Width -]
Cancel |
—Angular Width——  — Digplay & Color
A _I P
|| A0.0% Angular width at 0.0° [deg]
& 135% :
!I ' B0.0% Angular Width at 90.0° [deg]
i+ 50%

{* Both
" User [z]|E‘D-D |

Selection choices in the Time Statistics Parameters Dialog box are:
Angular Width

5% Angular width at the 5% clip level (% of peak).

13.5% Angular width at the 13.5% clip level (% of
peak).

50% Angular width at the 50% clip level (% of
peak).

User % Angular width at the user specified clip level

% (% of peak).

Numerical Aperture

5% Numerical aperture at a 5% clip level (% of
peak).

13.5% Numerical aperture at a 13.5% clip level (% of
peak).

50% Numerical aperture at a 50% clip level (% of
peak).
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User % Numerical aperture at a user specified clip level

%.
Angular Centroid Value of the first moment of angular scan data
Angular Peak Angular value of the peak
Angle Ratio In Perpendicular Axes Scan Mode, the ratio of

the angular width at angle ¢ to the angular
width at angle ¢ +90°.

5% Angular width ratio at the 5% clip level (% of
peak).
13.5% Angular width ratio at the 13.5% clip level (%
of peak).
50% Angular width ratio at the 50% clip level (% of
peak).
User % Angular width ratio at the user specified clip
level (% of peak).
Amplitude
Centroid Signal amplitude at the centroid.
Peak Signal amplitude at the peak.
User(deg) Signal amplitude at the user specified scan
angle. The angle range is [-90°, 90°].
Axes... Opens the Time Statistics Axes dialog box for
setting the chart axes.
Time Stat Axes |
= Buis o L
kiry kin Unitz
1] j |1 j IF'::nnts j
b 0 b &
1 ﬂ W &uto |1':I j M Auto
Cancel |
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Some of the options can also be selected using the Time Statistics window
toolbar.

b Starts Data Collection.

n Stops Data Acquisition.

X Clears and Resets the Time Statistics
Window.

H Turns the Grid Overlay On or Off.

o Turns the Statistic Calculation Overlay Text
On or Off.

wrZ Opens the Time Statistics Parameter Dialog
Box.

= Turns the Axes Overlay On or Off.

6.6.8. Power

Open the Power window. The Power window displays a graph of the
cumulative angular power, numerical values (up to 3) of the power within
specified cone angles, numerical values (up to 3) of the cone angles
containing specified percentages of the total power, and the 6 and ¢ values
of the angular 3D centroid of the profile. The cumulative power graph and
associated parameters are determined along either the instrument optical
axis or the 3D centroid axis.
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|"& Power - Photon Inc.

& 2] w1

Power in cones around optical axis (m) Total Power (myW)  1.000

POWER WITHIN CONE

0.17%5

0.480

0.993

CONE WATH % POWER

25.00 % 6.221°

50.00 % 10.373°

75.00 % 16.398°

3D CENTROID

Theta

The Options Menu available when the Power window is active is shown
below. The selections are:

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 83



Optical Axis

Centroid

Parameters...

Power Parameters

Piower within cane
¥ Core &ngle [
¥ Core &ngle [
¥ Core sngle [

Options

v [Optical Axis
Centroid

Parameters. ..
Colors. ..

When selected, the power calculations are
performed about the instrument optical axis.

When selected, the power calculations are
performed about the 3D centroid axis.

Opens the Power Parameters dialog for
selecting up to 3 cone angles for reporting
"Power within cone", and up to 3 percentages
of the total power for reporting the "Cones with
% power". Angles can be entered in degrees or
as Numerical Aperture if the "Display angle as
NA" box is checked. In this case the angles will
also be reported as NA in the Power window.

|
Cone with = power

|5 ¥ Power [%]: |25 |
Im— ¥ Power [%]: IEEI— cenee
|45 V' Power [%]: |?5

[T Display angle az M

Colors...

Opens a Colors dialog box, used for selecting
the color scheme for the Power window. Colors
for the background, text, grid and data can be
independently set. To change a color, click on
the appropriate color “button” to open a
Windows color selection dialog box.

Colors
B ackground |
T ext color |
[Gnid colar |
Drata |

Goniometric Radiometer Manual

Document No. 50269-001 Rev B 12/06/2012 Page 84



The options can also be selected using the Power window toolbar.

s When selected, the power calculations are
performed about the instrument optical axis.
A When selected, the power calculations are
performed about the 3D centroid axis.
wrE Opens the Power Parameters Dialog Box.
i1 Opens the Color Selection Dialog Box.
6.6.9. Notes

Opens the Notes Window used for entering user information.

= MNotes - Photon Inc. M=] &3

Euniumetric Radiometer =
anufacturing Test 10§15/1998

Diode S/N 23854

Test Engineer JLG

Kl el

6.7. Status Bar

The Status Bar, shown below, appears at the bottom of the main window.
The value for the Aperture-Source Distance, the gain setting, and the
detector type are reported here.

FarHelp, press F1 |Distance: 0.20  |[Gain: 84 |Detector: InGaAs i

6.8. Toolbars

Toolbars are provided to speed access to some of the most commonly used
operations and features of the Goniometric Radiometer program. Instead of
accessing these features through the pull-down menus, simply click on the
appropriate icon buttons on the toolbars. The operations and features
include: opening windows, turning data collection on and off, selecting the
scan mode, and selecting options. In addition, some file handling operations
such as opening and saving files, opening new files, and printing can be
initiated in this way. General program features are accessed on the main
toolbar, while options features specific to each window are accessed on
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local window toolbars. For user convenience and preference, toolbars can
be placed at different screen locations by “dragging and dropping”.

The main toolbar and descriptions of the icon buttons and functions are
given below. The local window options toolbars were described previously
under the individual window descriptions.

=Sk > 1 L] P2 25 R0

s

New File, opens a new file
File Open, opens a stored file
Saves the current file

Prints the current screen
Opens the Help Menu

Turns Auto Gain On or Off

Starts/Stops Data Collection for Single Axis
and Perpendicular Axes Scan Mode

Selects Single Axis Scan Mode

Selects Perpendicular Axes Scan Mode
Replay 3D Scan Data

3D Scan Mode; starts a 3D Acquisition
Replay 3D Centroid Data

Opens the Rectangular View Window
Opens the Polar View Window

Opens the 3D Polar View Window

Goniometric Radiometer Manual Document No. 50269-001 Rev B 12/06/2012 Page 86



Opens the 3D Rectangular View Window

n Opens the Topographic View Window

Opens the Beam Statistics Window

3%@ Opens the Time Statistics window, up to 15
o can be opened

o3 Opens the Power window
Opens the Notes window

6.9. System Messages

System messages alert the user to system actions, out-of-bound conditions,
and errors.

1. Scan Control and Data Acquisition Card Not Initialized

Goniometric R adiometer B

& Could not initialize board. Pleaze make sure all cables are connected and that the comect 1/0 address iz selected for the

board.

If after several attempts to start the program, this message continues to
appear, contact Spiricon.

2. Signal Saturated (Single Axis and Perpendicular Axes scan modes)

Beam Information!

Signal is saturated!

Decrease the signal gain.
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3. Signal Saturated (3D Scan Mode)

Goniometric Radiometer |

Signal iz zaturated!
Pleaze repeat the 30 meazurement with a lower zignal gain.

Decrease the signal gain.

4, Signal Level too Low (3D Scan Mode)

Goniometric B adiometer |

& Signal level is too low. Increasze signal gain.

Increase the signal gain.

5. 3D Acquisition Progress Bar

A0 Acquizition Progress

0% 100%

The acquisition can be cancelled by clicking on the “Cancel
Acquisition” button.

6. Motion Control Error (3D Scan Mode)

Motion Control Poszition Failure |

System diagnostics have determined an ermor in the motion contral system.
Diata may be corupted. Click the Rety button to take another data set.
[f failure persiztz, contact Photon (20 1-800-3PHOTOM.

Cancel |
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7. Reset Procedure Warning

Procedure warning |

Thiz operation will rezet all data views.
Do you want ko continue?

Selecting “Yes” will void all previously acquired data.
8. File Logging
File Logging

File name already exiztzl

Ovenyrite | Cancel |

Data log file already exist.

9. Graph Reset

Time Statistics for Angular Width - Photon Inc. |

The graph contains data that will be erazed by this operation
Eraze ?

10. Program Prompt

Program Terminating E |

& Leaving already?
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11. RS-232 Communication Failure

Goniometric Radiometer |

Q Mo communication with Goniometric B adiometer. Program aborted.

12. Invalid Vector Entry

Invalid Vector Entry |

& Crozg gections canhot be determined for thiz vectarl

The vector entered is out of bounds and the Computed Cross
Sections cannot be determined. Either make another selection or
close the Computed Cross Sections dialog.
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6.10. ActiveX Automation

It is possible to start, control and exit the Goniometric Radiometer
Acquisition and Analysis Software using ActiveX Automation. The software
is an automation server. You need to start the software at least once so that
the appropriate information can be added to your Windows registration
database. After that, you can start and operate the software using any
ActiveX Automation compliant client application.

The gonio32.tlb file in the Automation folder where the software has been
installed contains the prototypes of the interface function. You can open and
view the Type Library with an OLE2viewer program.

A sample file, GonioOLE2.xls, is written in Visual Basic for Applications
using Microsoft Excel 95. It demonstrates the use of some of the automation
methods the Goniometric Radiometer Acquisition and Analysis Software
exposes (see section 6.9.25).

The interface methods and properties that the Goniometric Radiometer
Acquisition and Analysis Software exports are explained below.

Note: This version of the Automation interface exports only the data from
the current scan. The current scan (scan at the current “Phi” angle) is
characterized by:

e the number of data points in the scam (profile). A typical value is
3241. This number is returned by the GetNumPts method,;

e the amplitude of each data point. The array of data point value
(amplitude) in the current scan is returned by the GetProfileData
method,;

e the “Theta” angle that corresponds to each data point. The array of
angles in the current scan of each data point is returned by the
GetProfileAngle method.

6.10.1. ApertureSourceDistance

Property Type:

VT _R4 - aperture source distance in cm

Remarks:

Sets or retrieves the value of the distance between the datum plane of the
entrance aperture and your source. For a detailed description of the
significance of the aperture source distance, please read section 4.1.9.
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6.10.2. AutoGain

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_NONE - none

Remarks:

Perform an Auto Gain (which automatically sets the amplifier gain) for the
scan from the current Phi (azimuth) angle.

6.10.3. BlindSpotCorrection

Property Type:

VT_BOOL - blind spot correction

Remarks:

Enables / disables blind spot correction. For a description of the “blind spot”,
please refer to section 5.5 and section 5.6.

6.10.4. Datalncrement

Property Type:

VT _I2 - increment to decimate scan data / angle

Remarks:

Set or retrieve the increment value for decimate scan data / angle. For
example, if you will set the increment to 10, data (angle) exported through
GetProfileData (GetThetaAngle) will be (usually) data from indexes 0, 10,
20, 30, 40, 50, ..., 3240. GetNumPts will return the real number of exported
points (which in this case will be 324 instead of 3241)

6.10.5. Exit

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_NONE - none

Remarks:

Closes the Goniometric Radiometer software application.

6.10.6. GetCenter

Method Return Value:

VT_R4 - centroid position

Method Parameter List:

VTS _NONE - none

Remarks:

Returns the centroid position in degrees.

This version of the Automation interface exports only the data from the
current scan.
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6.10.7. GetCurrentPhi

Method Return Value:

VT_R4 — current Phi angle in degrees

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the current azimuth scan (Phi) angle in degrees.

This version of the Automation interface exports only the data from the
current scan.

6.10.8. GetNA

Method Return Value:

VT_R4 - numerical aperture

Method Parameter List:

VTS_RA4 - cliplevel used for numerical aperture computation as a percent
value (e.g. 13.5 for 13.5%).

Remarks:

Returns the numerical aperture.

This version of the Automation interface exports only the data from the
current scan.

6.10.9. GetNumPts

Method Return Value:

VT _I2 - number of points.

Method Parameter List:

VTS_NONE - none

Remarks:

Returns how many data points are in the current scan.

This version of the Automation interface exports only the data from the
current scan. This value can be changed by setting an increment with
Datalncrement.

6.10.10. GetPeaklrradiance

Method Return Value:

VT _I2 - value of the irradiance of the peak.

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the irradiance of the peak in counts. Possible value are 0...255.
This version of the Automation interface exports only the data from the
current scan.
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6.10.11. GetPeakPosition

Method Return Value:

VT_R4 - peak position

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the peak position in degrees.

This version of the Automation interface exports only the data from the
current scan.

6.10.12. GetPeakWidth

Method Return Value:

VT_R4 - angular width

Method Parameter List:

VTS_R4 - cliplevel used for angular width computation as a percent value
(e.g. 13.5 for 13.5%).

Remarks:

Returns the angular width in degrees.

This version of the Automation interface exports only the data from the
current scan.

6.10.13. GetProfileAngle

Method Return Value:

VT_VARIANT - profile angle array

Method Parameter List:

VTS_NONE - none

Remarks:

Returns an array of angle value points that represents the angle in radians
for each data point. The number of points in the returned data array is the
number returned by the GetNumPts method. Please note that the array of
angle values changes each time you change the aperture-source distance,
because the latter parameter affects the Field of View (refer to section 5.2).
This version of the Automation interface exports only the data from the
current scan.

6.10.14. GetProfileData

Method Return Value:

VT_VARIANT - profile data array

Method Parameter List:

VTS _NONE - none

Remarks:

Returns an array of data points that represents the profile in counts. The
number of points in the returned data array is the number returned by the
GetNumPts method. To get the correct distribution of the data, you need to
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call GetProfileAngle, to get the theta angle value that corresponds to each
data point.

This version of the Automation interface exports only the data from the
current scan.

6.10.15. Go090Deg

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_BOOL - direction flag

Remarks:

Changes the azimuth scan angle by + or — 90° for data acquisition and
computing. When the parameter is TRUE the azimuth scan angle increases
by 90° (e.g. from 0° to 90°) and when the parameter is FALSE the azimuth
scan angle decreases by 90° (e.g. from 90° to 0°). This function operates
without any home checking routine. It is recommended occasionally to
check for “Home Position” with MotorGoHome.

6.10.16. GoToPhiAngle

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_RA4 - value of phi angle in degrees. Possible values are 0°...180°.
Remarks:

Selects the azimuth scan angle for which data will be acquired and
computed. When the Goniometric Radiometer software is running as an
ActiveX server, the scanning data mode should be set to the default value of
“Single Axis Scan”. The “current” data acquired is the data for the selected
phi (azimuth) angle. Phi values are form 0° to 180°, in increments of 0.225°.
If the Phi value used as parameter is not a multiple of 0.225°, the closest
value smaller than the selected Phi value will be used.

6.10.17. IncrementPhi

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_12 — number of azimuthal scans intended to be performed for a 3D
acquisition. Possible values are 10, 20, 50, 100, or 200.

Remarks:

Incrementally moves the entrance aperture by the Phi angle corresponding
to the specified number of scans (e.g. 18° for 10 scans, 9° for 20 scans
etc.), useful for 3D data acquisition. After the entrance aperture is moved the
system automatically acquires and processes one scan at the previously set
gain, independent of the status of ScanAcquisition. As a consequence, the
user can get the new data set without switching ScanAcquisition on and
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off. At the end of a 3D acquisition sequence it is recommended to return the
entrance aperture to the “Home Position” with MotorGoHome and check
the return value in order to ensure the data was acquired at the proper
azimuth angles.

6.10.18. IsSaturated

Method Return Value:

VT_BOOL - saturation flag

Method Parameter List:

VTS_NONE - none

Remarks:

Returns TRUE if signal is saturated, FALSE otherwise.

6.10.19. MotorGoHome

Method Return Value:

VT_BOOL - flag

Method Parameter List:

VTS_NONE - none

Remarks:

Sets the system to the 0° azimuth angle. The difference between
MotorGoHome and GoToPhiAngle with an input value of 0°is that during
the MotorGoHome routine, an extra hardware check insures the
correctness of the 0° azimuth angle. The FALSE value returned in flag
specifies if there has been detected an error in the motion control system
when trying to move the motor from the previously selected Phi angle to the
home position. You may want to call this function in your program to check
the motion control system is working properly. You should call this function
after a call to GoToPhiAngle with a Phi parameter value different than 0. If
this function consistently returns FALSE, contact Ophir-Spiricon.

6.10.20. PulsedMode

Property Type:
VT_BOOL - pulsed mode
Remarks:

Set or retrieve the pulsed mode of operation.

6.10.21. ScanAcquisition

Property Type:

VT_BOOL - global data acquisition

Remarks:

Sets or retrieves the status of data acquisition. If the value is TRUE, the
system is acquiring data.
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6.10.22. ShowWindow

Property Type:
VT_BOOL - show flag
Remarks:

Shows or hides the Goniometric Radiometer Acquisition and Analysis
Software main window. Call this function with FALSE as parameter to hide
the Goniometric Radiometer Software. Call this function with TRUE if you
want to show the Goniometric Radiometer window.

6.10.23. SignalGain

Property Type:

VT _I2 - signal gain value in dB

Remarks:

Sets or retrieves the value of the signal gain in dB.

Possible values are 0...139 for InGaAs detector and 0...159 for Si detector.

6.10.24. SourceFrequency

Property Type:

VT_R4 — source frequency in kHz

Remarks:

Set or retrieve the pulse repetition frequency of the source.

6.10.25. Sample file for ActiveX

Please note that in order to get correct numbers, you need to
Setup the software to acquire data

Set the correct aperture-source distance

Select a reasonable signal gain

Determine and set the azimuth angle for which data is acquired and
computed

Now, you can query the Goniometric Radiometer software for computed
values as angular width, centroid and peak position of the distribution, raw
scan data for a selected azimuth angle.

These are fragments from Visual Basic code that show how to use some of
the automation interface functions:

Dim Gonio As Object

Sub OpenSW ()

Set Gonio = GetObject ("", "Gonio.Document")
' start Goniometric Radiometer application and
' get a reference to the ActiveX object
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Gonio.ScanAcquisition True
' start (enable) data acquisition

Gonio.ApertureSourceDistance 0.1
' tell software that the distance between the
' source and the aperture is 0.lcm

Gonio.SignalGain 77
' set the signal gain to 77dB

Gonio.GoToPhiAngle 90

' 'go to azimuth angle phi=90°. (set the software
to
' acquire data for an azimuth angle of 90 deg)

End Sub

Sub CloseSW ()

Gonio.Exit
' close the Goniometric Radiometer software

End Sub

Sub GetWidth ()
ActiveSheet.Cells (1l,1) .Formula =
Gonio.GetPeakWidth (13.5)

get the angular width at 13.5% and display it in
a cell in the active spreadsheet. The return
value can also be written to a variable and

used later in the program

v
v
\
\

End Sub

Sub GetCenter ()
ActiveSheet.Cells (2, 1) .Formula = Gonio.GetCenter ()

get the centroid position and display it in a
cell in the active spreadsheet. The return
value can also be written to a variable and

v
'
'
' used later in the program

End Sub

+For a detailed example written in Visual Basic, please refer to the
GonioActiveX.xls file located under Automation, in the folder where the
software has been installed.
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7.1,

LD 8900R Acquisition
and Analysis Software

Quick Start

12. Turn on the PC.

13. Turn on the Goniometric Radiometer.

14. Start the Goniometric Radiometer Program by double-
clicking on the program icon on your monitor screen; or,
from the Windows Start menu, select Programs, then
PHOTON, and then Goniometric Radiometer.

15. After a few moments a message will appear informing the
user that the RS-232 Communication link is being
established, with a reminder to set the Aperture-Source
Distance.

E stablizhing 5232 communication. ..
R emember to zet the aperture - source
diztance before vou start acquinng data.
16. If RS-232 communication is established, the program will

start after a few more moments. The main window will
appear with the Rectangular View window and the Beam
Statistics windows open, as shown below. The system
will be in the Single Scan Mode.
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Goniometric Radiometer - sample. gdf [_ O]

ElZHEM % » [T L D2 2 nEnEcsE

. Rectangular View - Photon inc. O] x| I i Beam Statistics 0 samples - Photon Inc. Mi=] &3 |
s || AR 2= ||

Farameter | Walue | hean ‘ bdin | hl B¢ | Sitd Devw |
B0.0% AngularWidth at 0.0° (deg)

Angular Centroid at 0.0° (deg)

Angular Peak at 0.0° (deg)

Amplitude (Relative units) Phi = 0.000°
1.0|

T g0 70 60 50 40 300 -200 -100 0 100 200 30 4% 50 G0 70 60 90

For Help, press F1 |Distance: 0.00  |Gain: 0 | Detector: InGats A

17. If RS-232 communication is not established, the following
message will appear after approximately 30 seconds. In
this case, click “OK”, then check that the RS-232 cable is
securely connected, verify the COM port connection, and
ensure the Goniometric Radiometer is powered on. Then
go back to step 3 above. If the problem persists, contact
Spiricon.

Goniometric B adiometer |

Q Ma communication with Goniometric B adiometer. Program abaorted.

18. Set the Aperture-Source Distance in the Aperture-Source
Distance dialog box accessed under the Data Collection
Menu.
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Data Collection

Acguire Scan Data
Scan Mode

Chrl+

Acquire A0 Data
A0 Azimuth Scanz...
FReplay 30 Data...

Computed Crozs Sections...

Senzitiviby. .

Aperture-Source Diztance. ..

Pulzed Mode...

Ehi...

Beference Fower...
Inteqgral Parameters. .

Lnits

Auto Gain Clrl+
v Blind Spot Corection

Fecompute Ctrl+F

Aperture-Source Distance

Aperture-zource distance [cm) ; IEI

Cancel |

19. Turn on data acquisition by selecting Acquire Scan Data
under the Data Collection Menu, or by clicking the left
mouse button on the Data Collection icon >
on the main toolbar.

located

20. Set the Scan Amplifier gain in the Sensitivity Dialog box,
accessed under the Data Collection Menu. Make sure

your Device Under Test is powered on.

Sensitivity
Gain [dB): |'3 _,;'
Filter: 1 —
— Averaging
% User 1 = E stimated Time:
£ Loy I Single Mode: I
= Fedium I Perpendicular Mode: I
€ High | ‘
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21. Increase the gain setting until you observe a signal in the
Rectangular View window. Continue increasing the gain
until just below saturation to achieve the best vertical
resolution.

22. The values for the 50% angular width, the Peak angle
and the Centroid angle will be displayed in the Beam
Statistics window. You are now acquiring data at the
default azimuth scan angle of 0°. It's that simple.

7.2. Advanced Use

The previous Quick-Start procedure utilizes only the very basic features of
the Goniometric Radiometer software program. The program is very
powerful and flexible, allowing users to configure the analyses and the
information display windows to suit their individual needs. Users can arrange
and size multiple windows as required, and these screens can be saved as
files for future use. Also, data can be exported to spreadsheets, math and
statistical analysis programs, and process/instrumentation programs by
logging data to files or COM ports, or shared using ActiveX.

At this point, take a few minutes to read the rest of this section, which
includes detailed descriptions of the software features that control the
various scanning modes and ways to analyze, display and log data. The
software is also described in the On-line Help. A little time spent in advance
learning the features of the system will go a long way in making the
Goniometric Radiometer an invaluable resource for far field source
characterization.

7.3. Scan Modes

There are 3 scan modes for data acquisition. The 3 scan modes are:

4. Single Axis Mode,

5. Perpendicular Axes Mode, and

6. 3D Mode
The Scan Mode is selected under the Data Collection Menu, or by clicking
the tool bar icons:

Selects the Single Axis Scan Mode
_L Selects the Perpendicular Axes Scan Mode
’31:- Selects the 3D Scan Mode
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The Single Axis and Perpendicular Axes Modes provide the most rapid
characterization of a source. The 3D Mode takes more time but provides the
most complete characterization.

7.3.1. Single Axis Mode

In the Single Axis Mode, the system performs scans along 1 azimuth angle.
The angle of the scan can be set using the Phi Angle dialog box. This dialog
is accessed under the Data Collection Menu by selecting “Phi...” Offset
angles ranging from 0 to 180° in increments of 0.225° can be selected from
the list in the Dialog box. The default Phi angle is 0°.

7.3.2. Perpendicular Axes Mode

In the perpendicular axes mode, the system performs two scans in
orthogonal directions. The first scan is made at the angle set in the PHI
Angle dialog box. The second scan is made at this angle plus 90°.

7.3.3. 3D Scan Mode

In the 3D mode, a series of measurements are made at incremental azimuth
(Phi) angles ranging from 0° to 180°. The incremental angles available are
18°, 9°, 3.6°, 1.8° and 0.9°. Respectively, the number of scans made for
these 3D measurements are 10, 20, 50, 100, and 200.

7.4. Viewing Data

The acquired data can be viewed in various ways using the different
windows. The windows are:

9. Rectangular View;

10. Polar View;

11. Beam Statistics;

12. Time Statistics (up to 15 can be opened);
13. 3D Rectangular View;

14. 3D Polar View;

15. Topographic View;

16. Power View.

Data acquired in the Single Axis and Perpendicular Axes Modes can be
displayed in the following Windows:

Rectangular View The Rectangular View window displays a graph
of amplitude or intensity vs. scan angle in
Cartesian coordinates of the data sets acquired
for either one or both scans.
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Polar View The Polar View window displays a graph of
amplitude or intensity vs. scan angle in polar
coordinates of the data sets acquired for either
one or both scans.

Beam Statistics The Beam Statistics window displays numerical
values of parameters obtained from the scan
data. The parameters are angular beam width,
numerical aperture, angular beam width ratios,
centroid angle, peak angle, centroid amplitude,
peak amplitude, amplitude at user specified
angles. It also displays the Mean, Minimum,
Maximum, and Standard Deviation values, and
the Maximum Limit and the Minimum Limit for
parameter limit testing.

Time Statistics The Time Statistics windows are displays of
parameter values versus the sample number.
Up to 15 Time Statistics windows can be
opened.
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Data Acquired in 3D Mode can be displayed in the following windows:

3D Rectangular View The 3D Rectangular View window displays a
representation of the source profile in
cylindrical coordinates, with the data as the
height or “z” value, above the (6, ¢) plane. The
view perspective is looking toward the source.

3D Polar View The 3D Polar View window displays the data in
spherical coordinates, with the data as the
radius from the origin. The perspective of this
view is looking toward the source.

Topographic View The Topographic View window displays the
relative amplitude of the data acquired in a 3D
scan in a false-color format on a polar grid of &
and ¢. The perspective of this view is looking
from the source.

Rectangular View The Rectangular View window is used to
display data after a 3D acquisition. Select the
Replay Mode or the Centroid Replay Mode
from the Data Collection Menu, or click the
Replay or Centroid Replay icon.

Polar View The Polar View window is used to display data
after a 3D acquisition. Select the Replay Mode
or the Centroid Replay Mode from the Data
Collection Menu, or click the Replay or
Centroid Replay icon.

Power The Power window displays a graph of the
cumulative angular power, numerical values
(up to 3) of the power within specified cone
angles, numerical values (up to 3) of the cone
angles containing specified percentages of the
total power, and the 6 and ¢ values of the
angular 3D centroid of the profile. The
cumulative power graph and associated
parameters are determined along either the
instrument optical axis or the 3D centroid axis.
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7.5. Pull-Down Menus

7.5.1. File Menu

The “File” Menu is used for opening and closing files, saving files, setting
preferences at program startup, and for printing. When “File” on the Menu
Bar is clicked, the pull-down menu below appears:

New

Open...

Close

Save

Save As...

Hew Chrl+M
Open... Chrl+0
Cloze

Save Ctrl+5
Save fs

Preferences k

Frint... Chrl+P
Frirt Setup. ..

EecentklE

E xit

Halts data collection, closes all open windows,
and then opens a new file with the
Rectangular View window displayed.

Opens the File Open dialog box. It lists Data
Files from the current working directory. To
open a data file, select one from the list and
then select the Open button. All windows will
be closed and the new file will be loaded. The
data, windows and computed statistics from the
file will be displayed.

Halts data collection and closes all open
windows.

Saves the current data and windows
configuration in the currently active folder. The
name of this file is displayed on the main
window title bar.

Opens the File Save As dialog box. It lists
Data Files from the current working directory.
Either select an existing file from the list or
enter a new name in the File Name edit box.
To save as a data file, simply select the Save
button. Otherwise, select the desired file type
from the Save As Type combo box. There are
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*.grs

*.cfg

*.prw

*.asc

*.bmp

Preferences

Timed Backup...

5 different file types, identified by their
extensions:

Goniometric Radiometer  Acquisition and
Analysis Program Data File. This file can only
be used by the Goniometric Radiometer
software. The configuration of the screens,
system settings, and the beam measurements
(data) are saved.

Configuration File. This file can only be used by
the Goniometric Radiometer software. The
configuration of the screens and the system
settings are saved.

3D Data File. This file is in binary format and
contains data from the last 3D Acquisition. It is
provided for users to perform custom off-line
analysis using their own code. This file type
cannot be imported back into the Goniometric
Radiometer Software. The structure of the file is:

number of scans, stored as unsigned short
type (2 bytes);

number of points, stored as unsigned short
type (2 bytes);

Theta Angles: “number of points” values stored
in radians, as float type (4 bytes).

Data: “number of scans x number of points”
values, stored as short type (2 bytes). Data are
stored scan after scan (each scan has “number
of points” values corresponding to the Theta
Angles). The value of the Phi Angle (deg) is
180° / (number of scans) x (number of current
scan - 1).

ASCII File. The file contains profile data and
the data from each view in ASCII format.

Bitmap File. Saves the program screen as a
Bitmap File.

Configures user preferences on startup and
exit.

Preferences Timed Backup...
On Power Up +
r Exit »

Opens the Automatic Data Backup dialog box,
for configuring if and when backups are to occur.
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On Power Up

Load Previous
Setup

Global Collect On
Background Logo

On Exit

Save Setup

Prompt

Print...

Print Setup...

Exit

If the Backup On checkbox is selected, then all
data will be saved automatically at the specified
interval. Use this feature when collecting data
over extended periods to prevent data loss in the
event of a power outage or other catastrophe.
When the program is restarted after such an
event, the backup file will load and data
collection will resume from the point of the last
automatic save.

Automatic Data Backup E |

¥ Backup On

Backup Interal
=l .
|1 I} = minutes
Cancel |

Opens a menu with the following selections:

O Power Up d  Load Previous Setup
Global Collect On
Background Logo

When checked, the last saved data file will
automatically load at startup.

When checked, data collection resumes at
startup.

When checked, the Photon Logo appears as
the background for the main window.
Opens a menu with the following selections:

O Exit Save Setup
Frompt

When checked, the user is prompted to save
the latest data as a .GRD or configure as a
.CFG file upon exit.

When checked, the user is prompted with the
message “Leaving Already?” upon exit.

Opens the Print dialog box, used for printing
the program screen.

Opens a dialog box for selecting and
configuring printers.

Exits the program.
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7.5.2. Edit Menu

When “Edit” on the Menu Bar is clicked, the pull-down menu below

appears:
Copy Chrl+C |

Copy Copies the active window to the Windows
clipboard as a bitmap image. From there, the
bitmap can be pasted into other program
applications.

7.5.3. View Menu

When “View” on the Menu Bar is clicked, the pull-down menu below
appears:

v Main Toalbar
v Local Toolbar

v Status Bar
Main Toolbar When checked, the toolbar on the main window
is visible.
Local Toolbar When checked, the toolbar of the currently
active view is visible, if available.
Status Bar When checked, the status bar at the bottom of

the main window is visible.

7.5.4. Options Menu

Various options associated with the window views can be selected under the
“Options” menu when that particular window is active. The list of options
are unique for each window type. The options list can be found under the
window descriptions.
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7.5.5. Data Collection Menu

The “Data Collection” menu includes selections, which determine or affect
the collection of data. When “Data Collection” on the Menu Bar is clicked,
the pull-down menu below appears:

Acquire Scan Data

Scan Mode

Acquire 3D Data

3D Azimuth Scans...

Data Collection

Acguire Scan Data Chrl+5
Scan Mode 3

Acquire 30 Data

30 Azimuth Scans. ..
Feplay 30 Data...
Computed Cross Sections. ..

Senaitivity...
Aperture-5ource Distance. ..
Pulzed Maode. ..

Phi...

Reference Power. ..
Integral Parameters. ..

Unitz 3
Auto Gain Chrl+&,

v Blind Spot Correction
RecampLite Ctrl+H

Turns data acquisition on or off when operating
in either Single Axis or Perpendicular Axes
scan modes.

Selects either the Single Axis or Perpendicular
Axes Scan Modes.

Scan Mode *  Single Axiz
Perpendicular Ares

Starts 3D data acquisition.

Opens a dialog for selecting the number of
azimuthal scans for a 3D acquisition, either 10,
20, 50, 100 or 200. The corresponding angular
increments are 18°, 9°, 3.6°, 1.8° and 0.9°.

3D Azimuth Scans

Murnber of scans
[degree I‘IEI [18.07] *I
increment] Canicel |
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Replay 3D Data... Turns on the Replay Mode, where data
acquired in the last 3D scan can be viewed in
either the Rectangular View, Polar View or
Beam Statistics window. The azimuth angle of
the scan is selected in the combo box. To exit
the Replay mode, press the Cancel button.

Replay

Display Dataat (0000 =]

Computed Cross Turns on the Computed Cross Sections Replay

Sections... Mode. In this mode, orthogonal cross sections
computed using the scan data obtained from
the last 3D acquisition are displayed in either
the Rectangular View or Polar View. The
parameters for the computed cross sections
are displayed in the Beam Statistics window.
The computed cross sections can be through
either the 3D Centroid, the 3D Peak, or through
an Arbitrary Vector. This selection is made in
the Computed Cross Sections dialog, which
appears after selecting the Computed Cross
Sections Replay Mode. The offset azimuth
angle of the first computed cross section is
entered in the edit box. For offset “0”, the
computed orthogonal cross sections are in the
directions of the major and minor axes of the
Centroid intensity distribution. To exit the
Computed Cross Sections Replay Mode, press
the Close button.

Computed Cross Sections E3
Reference Direction
=" 30 Centroid
i~ 3D Peak

¢ 3D User Defined  Theta [deq): IEI Phi [deg]:l[l

Offset from MajorMinor Axes [deq] : ID

Cloze |
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Sensitivity... Opens the Sensitivity Dialog Box. This dialog
box is used to manually set the Gain, Filter and
Average settings for data presentation. The
gain can be set over the range from 0 to 139
dB for InGaAs detectors and from O to 159 dB
for Silicon detectors. The filter value sets the
number of points used in a consecutive sum
smoothing filter used in data analysis and
display. Values from 0O to 99 are allowed. The
Averaging Value sets the number of scans to
be averaged together before analysis and
displays. User selected values can range from
1 to 10,000. The Low, Medium and High
selections are not presently available and are

inactive.
Sensitviy |
Gan(B: |° =
A Cancel
Filter: h = —————————J
— Averaging
% Uzer |1 E E stimated Tirne:
0 (Lo I Sitgle Mode: I
£ Fedium I Perpendicular Mode: I
 High |
Aperture-Source Opens the Aperture-Source Distance Dialog
Distance... Box. This dialog box is used to enter the value

of the Aperture-Source Distance, i.e. distance
between the datum plane of the entrance
aperture and your source. The value is in
centimeters (cm). Resetting the value of the
Aperture-Source Distance will reset/void all
previously acquired data. A dialog box alerts
the user to this impending action.

Aperture-Source Distance |

Aperture-zource distance [cm] : IEI : :
Cancel |
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Pulsed Mode... Opens the Pulsed Mode Dialog Box. If you are
using a pulsed source, use this dialog box to
set the Pulsed Mode of operation and to enter
the pulse repetition frequency of the source.
When operating in Pulsed Mode, the peaks of
the individual pulses in the profile are
connected to form a smooth profile. All
parameter computations will be performed on
the resulting smooth profile. The allowable
frequency range is 0.1 — 20 kHz.

Pulsed Mode E4

¥ Pulzed Mode

Phi... Opens the Phi Angle Dialog Box. This dialog
box is used to select an offset Azimuth Scan
Angle for Single Axis and Perpendicular Axes
Scan modes. When operating in the Single
Scan mode, the scan will be performed at the
selected Phi angle. In Perpendicular Axes
mode, the first scan will be made at this angle
and the second scan will be made at Phi + 90",
The values available for selection range from 0
to 180° in 0.225 increments.

Phi Angle

Phi[deg] |0.000 @

Cancel |

Reference Power... Opens the Reference Power dialog box. Enter
the value of the measured reference power in
the edit box and select the units, either pWw,
mW or W, in the combo box.

Reference Power |
E;::éﬁme I'I itz | e’ -
Cancel |
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Integral Parameters... Opens the Integral Parameters dialog box. The
dialog box is used to set Wavelength and
Angular Integral Limits for the Petermann Il
Integral, in Mode-Field Diameter Computation.
Integral Parameters

W avelength [nm]; I1 310

shngular Limit [deqg): |4EI Cancel |

Units Opens the Units submenu for selecting the
units for the Rectangular View, Polar View,
Beam Parameters, and Time Statistics
windows. Choices available are Relative (%),
0-100%, Counts, 0-65535, or Intensity (W/sr).
The Intensity (W/sr) selection is only available
if a 3D acquisition has been performed.

IS - e (4

Countz
Intersity M e

Auto Gain Automatically sets the amplifier gain when
operating in either Single Axis Scan Mode or
Perpendicular Axes Scan Mode.

Blind Spot Correction Turns Blind Spot Correction on or off.

Recompute Use Recompute to reanalyze acquired scan
data or computed cross section data for either
the previous acquisition or for saved data files.

7.5.6. Window Menu

When “Window” on the Menu Bar is clicked, the pull-down menu below
appears:

ﬂ | lul d Ly

Mew Swfindow r

LCazcade
Tile
Arrange |cons

Cloze Al

v 1 Rectangular Yiew - Photon inc.

The Window menu is used to open new
windows, to arrange windows and window
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icons and to close all open windows. The list at
the bottom of the menu shows which windows
are open with the currently active window
checked.

New Window Opens a submenu for opening windows
available for viewing.

Bectangular Yisw F2
Eolar Yiew F3

30 Polar Yiew F4
3D Rectangular Yiew Fh
Topoaraphic: Yigw FE

Beam Statistics F7
Time Statistics Fg
Power F9
Hotes Fi2

7.5.7. Help Menu

Use the “Help Menu” to access Help Topics, directions on how to use the
On-line Help, and Goniometric Radiometer software version information.

Help Topics
Uszing Help

About Goniometric B adiometer...
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7.6.  Window Descriptions

7.6.1. Rectangular View

Open the Rectangular View window. This window displays the data from
either a single axis scan or perpendicular axes scans with measured
amplitude vs. angle in rectangular coordinates. Options for this menu are
accessed through the Options menu when the Rectangular View window is
active.

== Rectangular Yiew - Photon inc.
Lw | Alen]

nmplltude (Relative units) Phi = 0.000°

r‘l.
NH‘&
Y
/

Amplltude {Relatme umts} Phi = 90.000*
1.0

J—JJ ‘J
!
00 -¥0° -0 -30° -40° -30° -20° -10°
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The Options Menu available when the Rectangular View window is active is
shown below. The selections are:

Data Collection

Timing...

Zoom Angle...

Normalize

Options
Data Collection Ctrl+D
Timing...

Zoom Angle...
Harmalize
Scale r

Colors...

Turns data collection on and off.

Opens a dialog box for selection of the profile
update rate.

Timing |

Plat Frequency

|5 ILIpdatesfSeu: j

Cancel |

Opens the Zoom Angle Dialog Box. The Zoom
Angle Dialog box allows zooming to view a
section of the scan data in greater detail. It is
used to select the Angular Range, the Zoom
Offset Angle and the Grid Spacing. All values
are in degrees.

Zoom Angle | x| |

Zoom Range [7]; |13|:I

Zoom Offzet (7] I Cancel |
Zoom Grid [7] : I'IEI I

Scales the profile amplitude to have a peak
value of 1, i.e. full scale. (In Perpendicular
Axes Scan mode the normalization will be for
the largest amplitude scan).
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Scale Opens a submenu for selecting the scaling of
the vertical axis, either Linear or Logarithmic.

Linear »

Logarithrmic

When Linear is selected, a second submenu
appears for selecting the scale of the vertical
axis, either 1x, 10x, 100x, or 1000x.

oix
Logarithmic 10 =
100 =

1000 =

Some of the options can also be selected using the icons on the
Rectangular View window toolbar:

b Starts Data Collection

[ Stops Data Acquisition

W Normalize the Display

&L Opens the Zoom Angle Dialog Box
i1

Opens the Color Selection Dialog Box
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7.6.2. Polar View

Open the Polar View window. This window displays the data from either a
single axis scan or perpendicular axes scans with measured amplitude vs.
angle in polar coordinates.

Phi = 0.000°

1.0 LR LR o4 L1

Amplitude (Relative units) -
-B0
i |

The Options Menu available when the Polar View window is active is
shown below. The selections are:

QFIHI:I [k
Data Collection  Crl+D
Timing...

Zoom Angle...
Hormalize
Scale r

Colors...
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Data Collection

Timing...

Zoom Angle...

Normalize

Scale

Turns data collection on and off.

Opens a dialog box for selection of the profile
update rate.

Timing |

Plat Frequency

|5 ILIpdatesfSeu: j

Cancel |

Opens the Zoom Angle Dialog Box. The
Zoom Angle Dialog box is used to select the
Angular Range, the Zoom Offset Angle and
the Grid Spacing. All values are in degrees.

Zoom Angle E3 |

Zoom Hange [*] : I'IEEI

Zoom Offget [7]: I Cancel |
Zoom Grid [7] : I'IEI I

Scales the profile amplitude to have a peak
value of 1, i.e. full scale. (In Perpendicular
Axes Scan mode the normalization will be for
the largest amplitude scan).

Opens a submenu for selecting the scaling of
the vertical axis, either Linear or Logarithmic.

Linear r
Logarithrmic

When Linear is selected, a second submenu
appears for selecting the scale of the vertical
axis, either 1x, 10x, 100x, or 1000x.

vix
Logarithrmic 10 =
100 =
1000 =
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Colors... Opens a Colors dialog box, used for selecting
the color scheme for the displayed graph.
Colors for the background, text, grid and data
can be independently set. To change a color,
click on the appropriate color “button” to open
a Windows color selection dialog box.

Colors
B ackground |
Text color |
Grid color [ |
Data |

Some of the options can also be selected using the icons on the
Rectangular View window toolbar:

b Starts Data Collection

[ Stops Data Acquisition

W Normalize the Display

) Opens the Zoom Angle Dialog Box
i1 Opens the Color Dialog Box
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7.6.3. 3D Polar View

Open the 3D Polar View window. This window displays data from 3D
acquisitions in a “3-dimensional” viewing format in spherical coordinates.
The image can be rendered with either a wireframe or solid surface. The
view perspective is looking toward the source.

4 30 PolarView Photonine. M=K

hedy EACARNE)

Rotx Roty [T Zoom

The Options Menu available when the Polar View window is active is
shown below. The selections are:

Options

v Solid Surface

Clip Lewel ...
v Clip Legend

Bezalution 3
Scale k

Solid Surface When selected, the image will have a solid

surface. When not selected, the image will be
rendered as wireframe.

Clip Level... Not presently available.

Clip Legend Not presently available.
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Resolution Opens a submenu for selecting the resolution
of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

Beszalution (K]
I edium
High

Scale Opens a submenu for selecting the scaling of
the data in the display, either Linear or
Logarithmic.

3 v Linear
Logarithmic
The toolbar at the right border of the window contains 8 buttons used to

select several viewing and image manipulation features. These buttons
are, from top to bottom:

kl Chooses the “Arrow” cursor. Allows image
manipulation only using the mouse and the
thumbwheel controls.

@I Chooses the “Hand” cursor. Allows image
manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window
border the Hand cursor changes to the Arrow
cursor.)

This Help menu is inactive. Please use the
main Help menu.

Resets the view to a preset “Home” default
position, size and orientation.

Sets the default settings for the “Home”
button.

Restores the view to include the entire image.

Activates the “Seek” cursor. After positioning
this cursor on a selected point in the image
and clicking the left mouse button, a close-up
zoom to that point will be performed
automatically. Also, the center of rotation will
be set to that point.

&R = B =
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@ @I Toggles between the Orthographic and

Perspective projection modes.

There are also several “thumbwheels” along
IR
- — the window border, designated “Zoom”,

“Dolly”, “Rotx”, and “Roty”, which are used to
zoom and rotate the 3D image.

The image can be rotated, translated, panned, and zoomed using the
mouse with the Arrow cursor and the “thumbwheel” control knobs or using
the mouse with the Hand cursor, as described below.

Rotation Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
ROTX and ROTY. Alternatively, use the
mouse and the Hand cursor to directly rotate
the image; Position the hand cursor over the
image, depress the left mouse button, and
drag the mouse to obtain the desired
orientation.

Pan/Translate While depressing the control key <CTRL>,
use the mouse and the Hand cursor to directly
pan the image. Position the hand cursor over
the image, depress the left mouse button,
depress the control key, and drag the mouse
to move the image to the desired location.

Zoom The method for zooming the image depends
on the type of display projection selected. In
the Perspective projection mode, use either
the zoom control arrows at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window.
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7.6.4. 3D Rectangular View

Open the 3D Rectangular View window. The 3D Rectangular View window
displays the source intensity pattern in a “3-dimensional” viewing format in
cylindrical coordinates. The image can be rendered with either a wireframe
or solid surface, with user selected clip levels and colors. The perspective of
this view is looking toward the source.

|4 3D Rectanqgular View - Photon inc.

1 |<0 Bt g | | v [Ix]

ClipLevels(%5)

Rotx Roty Mo Zoom

The Options Menu available when the 3D Rectangular View window is
active is shown below. The selections are:

Options

v Solid Surface

Clip Lewvel ...
v Clip Legend

Beszolution 3
Scale 3

Solid Surface When selected, the image will have a solid
surface. When not selected, the image will be
rendered as wireframe.
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Clip Level...

Clip Legend

Resolution

Scale

Opens a dialog box for selecting clip level
contours and their colors.

ClipLevels for 3D Plots [ x|

Caolor  Clip Lewel

100.0% =~
90.0%
75.0%
60.7%

50.0% o
36.8% < OO

Clip Lewel

Add | Delete |

When selected, the clip level legend will be
displayed in the 3D window.

Opens a submenu for selecting the resolution
of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

4 W Low
edium
High

Bezalution

Opens a submenu for selecting the scaling of
the data in the display, either Linear or
Logarithmic.

3 v Linear
Logarithmic

The toolbar at the right border of the window contains 8 buttons used to
select several viewing and image manipulation features. These buttons

are, from top to bottom:

Ll

Chooses the “Arrow” cursor. Allows image
manipulation only using the mouse and the
thumbwheel controls.

Goniometric Radiometer Manual

Document No. 50269-001 Rev B 12/06/2012

Page 126



@I Chooses the “Hand” cursor. Allows image
manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window
border the Hand cursor changes to the Arrow
cursor.)

This Help menu is inactive. Please use the
main Help menu.

Resets the view to a preset “Home” default
position, size and orientation.

Sets the default settings for the “Home”
button.

Restores the view to include the entire image.

% [ o |

Activates the “Seek” cursor. After positioning
this cursor on a selected point in the image
and clicking the left mouse button, a close-up
zoom to that point will be performed
automatically. Also, the center of rotation will
be set to that point.

@ @l Toggles between the Orthographic and

Perspective projection modes.

i

There are also several “thumbwheels” along
NI
A — the window border, designated “Zoom”,

“‘Dolly”, “Rotx”, and “Roty”, which are used to
zoom and rotate the 3D image.

The image can be rotated, translated, panned, and zoomed using the
mouse with the Arrow cursor and the “thumbwheel” control knobs or using
the mouse with the Hand cursor, as described below.

Rotation Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
Rotx and Roty. Alternatively, use the mouse
and the Hand cursor to directly rotate the
image; Position the hand cursor over the
image, depress the left mouse button, and
drag the mouse to obtain the desired
orientation.
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Pan/Translate While depressing the control key <CTRL>,
use the mouse and the Hand cursor to directly
pan the image. Position the hand cursor over
the image, depress the left mouse button,
depress the control key, and drag the mouse
to move the image to the desired location.

Zoom The method for zooming the image depends
on the type of display projection selected. In
the Perspective projection mode, use either
the zoom control arrows at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window.

7.6.5. Topographic View

Open the Topographic View window. This window displays the data from 3D
acquisitions with false color in polar coordinates. The perspective of this
view is looking from the source.

|4 Topographic View - Photon inc. !EIB

5.0

ClipLevels(%6)
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The Options Menu available when the Topographic View window is active
is shown below. The selections are:

|:_| u] tians
Clip Level ...
v LClip Legend
Besolution  #
Scale 3
Clip Level... Opens a dialog box for selecting clip level

contours and their colors.

ClipLevels for 2D Plot [ x|

Color  Clip Lewel

100.0% =1 ClipLewel
90.02¢ —
15.02¢

=

60.7%
50.0% oo
36.8% et
acd | Delete |
0k Cancel |
Clip Legend When selected, the clip level legend will be

displayed in the 3D window.

Resolution Opens a submenu for selecting the resolution
of the 3D image, either Low (120 points per
scan), Medium (270 points per scan), or High
(540 points per scan).

Beszolution  » K
Medium
High

Scale Opens a submenu for selecting the scaling of
the data in the display, either Linear or
Logarithmic.

3 v Linear
Logarithmic
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Zoom To Zoom in, click and hold down the left
mouse button while dragging the mouse away
from the center. To Zoom out, click and hold
down the left mouse button while dragging the
mouse toward the center. To translate up,
down, left and right, simultaneously press the
Ctrl key and the Left Mouse Button, and drag
the mouse to move the image to the desired
location.

7.6.6. Beam Statistics

Open the Beam Statistics window. This window displays a tabular
summary of beam parameters and statistics. It is also used for Limit
Analysis. The parameters for viewing are selected in the Beam Statistics
Parameters dialog box.

B Beam Statistics 14 samples - Photon Inc. M=] E3
) Ln ] o

Farameter | Walue | Mean | Min | GEN | Std Dev | it Lirnit | I & Lirnit |
O B.0% Angular Width at 0.0° [deg] Fi<N| FAEd F4Y Y740 100 o a0.0
O 8.0% Angular Width at 90.0° [deg) 234 2345 232 238 D20 15.0 25.0
‘ 13.5% Angular width at 0.0° [deg) a2 310 BYY  BBE 025 B0.0 a0.0
‘ 13.5% Angular Width at 30.0° [deg] 191 1318 130 134 012 12.0 12.0
O B0.0% Angular wWidth at 0.0° [deg) 04 3032 300 05 014 250 350
O B0.0% Angular \Width at 30.0° [deg] 108 1084 108 109 005 0.0 200
O 20.0% Angular wWidth at 0.0° [deg) 158 1875 165 160 012 12.0 12.0
‘ 20.0% Angular \Width at 30.0° [deg] 58 RB0 &7 53 0.04 a.0 10,0
‘ A0.0% Angular wWidth at 0.0° [deg) .0 =RE]| 2.9 102 050 0.0 15.0
‘ A0.0% Angular \Width at 30.0° [deg] 32 326 32 33 0.0z 20
‘.-’-‘-.ngle Ratio at 5.0 2 Width 322 3226 36 334 0067 0.30 110
‘.-’-‘-.ngle Ratio at 13.5 % Width 04 3020 293 303 0029 5.00
O.-’-‘-.ngle Ratio at 50,0 % Width 28 2796 276 283 0023 1250
O.-’-‘-.ngle Fatio at 80.0 % Width 272 207 2ea 273 0027 0.00 200
‘.-’-‘-.ngle Ratio at 90.0 % Width 278 2BRE 2Va4 314 0147 1.00 250
o.-’-'-.ngular Centroid at 0.0° [deq] 0.0 003 0o 01 003 .0 5.0
o.-’-'-.ngular Centroid at 90.0° [deq) n.a na3s 07 1.0 0z 2.0 20
O.-’-‘-.ngular Peak at 0.0° [deq] n3 nos 07 ns 0.43 1.0 20
‘f-‘mgular Peak at 90.0° [deq) 11 117 10 14 01z 1.0 n&
O Centroid Amplitude at 0.0% (a.u.] N8s 0B854 084 086 0007 075 0490
‘ Centroid Amplitude at 90.0° [a.u.] nes 0B85 085 086 0003 075 nses
O Peak Amplitude at 0.0° [a.u.] nes 0878 087 083 0002 095
‘ Peak Amplitude at 90.0° [a.u.] nes  0B8s 083 083 Q0002 0.90
O.-’-‘«mplitude for Theta=-B.0°at00°[auw] 075 0750 074 06 (0006 0.50
‘.-’-'«mplitude for Theta=-B.0° at 90.0° [au] 040 0400 038 042 003 0.50
O.-’-‘«mplitude for Theta =5.0° at 0.0° [aw] 081 ne1d4 080 082 0003 0.E0 090
O.-’-‘«mplitude for Theta =5.0° 2t 90.0° [zw] 057 0530 085 0B0 QO6 0.50 07s
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Limit Analysis

Limit analysis can be performed on any of the parameters reported in the
Beam Statistics window. The parameters are checked against user
specified maximum and/or minimum values and the result of the analysis is
displayed using icons in the Beam Statistics window, as shown above. To
configure the analysis, either double click with the left mouse button on the
desired parameter, or, alternatively, use the Up/Down Arrow keys to
highlight the parameter and then press the Space key. This will open the
following dialog box for setting the parameter limits for the analysis.

13.5% Angular Width at 0.0° [deqg]

¥ Minimu W alue: IhD ] I
IV M amirnirn ' alue: |2|:| Ceriae] |

Either one or both limits can be set. The icons for reporting the analysis are:

0 Parameter value is within the set limit or
limits.

F Parameter value is greater than the maximum
limit.

v Parameter value is less than the minimum
limit.

The Options Menu available when the Beam Statistics window is active is
shown below. The selections are:

Options
Data Callection Chrl+D
Timing...

Rezet
Parameters. ..

Eont...

Log Chrl+L

Data Collection Turns data collection on and off.
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Timing...

Reset

Parameters...

Opens a dialog box for selection of the
window update rate.

Timing

Plat Frequency

X

|5 ILIpdatesfSeu: j

Cancel |

Resets the values on the Beam Statistics

window.

Opens the Beam Statistics Parameters

dialog box.

Beam Statistics Parameters

— &ngular Width / Mumernical Aperture
v 5% [v 5%

W 1356% ¥ 135%
W 50.0% [ 50.0%
WV Userz |50 W Uszerz
v Useriz |90 v Users

— &ngular *idth B atio
v 5
W 135%
W 50.0%
W Userz |80
v Uzer |90

—&ngular Pozition
v Centraid
¥ FPeak

— Amplitude
¥ Centraid
v Peak
W Uszer Angle(deql

0

W User Anglefdeg) |5

[+ Mode-Field Diameter

— Statiztics
' Continuous

' Roling I-“:I
' Finite |1EIEI

]|

Cancel |

— Dizplay
¥ alue
¥ Mean
v Min
v Max
¥ Std Dey
™ Min Limit
™ Max Limit

—Lagaing
Output & Mone

* File

v Date
¥ Time

" Port IEDME: vI
Delimiter; IEDmma vI

¥ Serial Mumber; IEIIJ'I

log

Selection choices in the Beam Statistics Parameters Dialog box are:

Angular Width

5%
13.5%

Angular width at the 5% clip level (% of peak).

Angular width at the 13.5% clip level (% of

peak).
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50% Angular width at the 50% clip level (% of

peak).

User % Angular width at the user specified clip level
%.

User % Angular width at the user specified clip level
%.

Numerical Aperture

5% Numerical aperture at the 5% clip level (% of
peak).

13.5% Numerical aperture at the 13.5% clip level (%
of peak).

50% Numerical aperture at the 50% clip level (% of
peak).

User % Numerical aperture at a user specified clip level
%.

User % Numerical aperture at a user specified clip level
%.

Angular Width Ratio  In Perpendicular Axes Scan Mode, the ratio of
the angular width at angle ¢ to the angular
width at angle ¢+ 90°.

5% Angular width ratio at the 5% clip level (% of
peak).

13.5% Angular width ratio at the 13.5% clip level (%
of peak).

50% Angular width ratio at the 50% clip level (% of
peak).

User % Angular width ratio at the user specified clip

level (% of peak).

User % Angular width ratio at the user specified clip
level (% of peak).

Angular Position

Centroid Value of the angular scan first moment
Peak Angular value of the peak.
Amplitude
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Centroid Signal amplitude at the centered.
Peak Signal amplitude at the peak.

User Angle(deg) Signal amplitude at the user specified scan
angle. The angle range is [-90°, 90°].

User Angle(deg) Signal amplitude at the user specified scan
angle. The angle range is [-90°, 90°].

Mode-Field Diameter Value of the MFD computed according to

FOTP 191.
Statistics

Continuous Selects a continuous average of data
samples.

Rolling Selects a rolling average with user specified
number of samples.

Finite Selects a finite average with user specified
number of samples.

Value Selects display of the present value of the
beam parameter.

Mean Selects display of the mean value of the beam
parameter.

Min Selects display of the minimum value of the
beam parameter.

Max Selects display of the maximum value of the
beam parameter.

Std Dev Selects display of the standard deviation of
the beam parameter.

Min Limit Selects display of the minimum limit value of
the beam parameter set in Limit Analysis.

Max Limit Selects display of the maximum limit value of
the beam parameter set in Limit Analysis

Logging

Output

Delimiter Selects the delimiter format for the logged
data.

None No data logging.
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File Data logging to specified file.

Port Data logging to serial port COM1 or COM2.

Date If selected, the date is attached to the logged
file.

Time If selected, the time is attached to the logged
file.

Serial No. If selected, the specified serial number is

attached to the logged file.

Font... Opens the Font Selection dialog box. This
allows the user to change the font of the text
in the Beam Statistics window.

Log If data logging is enabled, one additional set
of data is acquired and then displayed and/or
logged to the file. If data collection is disabled
for the Beam Statistics window, it allows the
user to take individual data one set at a time
and log it to a file. The Hot Key “Ctrl+L”
enables logging even if another window is
active as long as the Beam Statistics is open.

Some of the options can also be selected using the icons on the Beam
Statistics View window toolbar:

> Starts Data Collection.

m Stops Data Acquisition.

x Clears and Resets the Beam Statistics
Window.

% Opens the Beam Statistics Parameter Dialog
Box.
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7.6.7. Time Statistics

Open the Time Statistics window. The Time Statistics window displays strip
charts of beam parameters versus sample number or time. Any or all of the
computed beam parameters may be viewed in this way. Up to 15 Time
Statistics windows can be opened. Several overlays are available in the
options menu, including grids, statistical markers, and numerical statistical
summaries.

@ Time Statistics for Angular Width - Photon Inc.

, Ln [ e o]

10

10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200
Points

— 50.0% Angular YWidth at 0.0 (deg) 50.0% Angular Width at 90.0° {deg)|

Variahle Mean Min Max StdDev
50.0% Angular Width a 30.32 30.17 30.39 0.0480
50.0% Angular Width a 10.82 10.69 1091 0.0427

The Options Menu available when the Time Statistics window is active is
shown below. The selections are:

QFIHI:I [k
Data Collection Chrl+D
Timing...

Bezet Graph
v Gnd On
kean
Mirahd 2
Standard Deviation
Show Calculations

Eont...
Parameters. ..

Aues. .

Data Collection Turns data collection on and off.
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Timing... Opens a dialog box for selection of the
window update rate.

Time 5tat Timing |
— Automatic Data Collection
R ate Uitz Dhuration [pitz
= = -
|5 = IUpdatesHSec j I'I ooa = IF'l:ulnts j

— kanual Data Collection
MHurmber af Faints

™ Marual 1000 =
=1

Canzel |

Reset Graph Resets the chart.

Grid On Turns the grid overlay On or Off.

Mean Displays an overlay on the chart at the mean
value.

Min/Max Displays overlays on the chart at the minimum

and maximum values.

Standard Deviation Displays overlays on the chart at the standard
deviation value.

Show Calculation Turns the Statistics Calculation Overlay Text
On or Off. The overlay, displayed at the
bottom of the chart, shows the values for
mean, minimum, maximum and standard
deviation.

Font... Opens the Font dialog box. This allows the
user to change the font of the text in the Time
Statistics window.
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Parameters...

Opens the Time Statistics Parameters dialog
box for selecting chart parameters and the
color of the graph.

Parameters E |

I.ﬁ.ngular Width

— Angular *Width——
Bz

 135%
LOI

" User [2]|E=D-D |

-

Cancel |

— Digplay & Color

!l ™ B0.0% Angular 'Width at 0.0° [deg]
!l ™ B0.0% Angular Width at 90.0° [deq)
¥ Both

Selection choices in the Time Statistics Parameters Dialog box are:

Angular Width
5%
13.5%

50%

User %

Numerical Aperture

5%

13.5%

50%

User %

Angular Centroid

Angular Peak

Angular width at the 5% clip level (% of peak).

Angular width at the 13.5% clip level (% of
peak).

Angular width at the 50% clip level (% of
peak).

Angular width at the user specified clip level
% (% of peak).

Numerical aperture at a 5% clip level (% of
peak).

Numerical aperture at a 13.5% clip level (% of
peak).

Numerical aperture at a 50% clip level (% of
peak).

Numerical aperture at a user specified clip level
%.

Value of the first moment of angular scan data

Angular value of the peak

Goniometric Radiometer Manual
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Angle Ratio In Perpendicular Axes Scan Mode, the ratio of
the angular width at angle ¢ to the angular
width at angle ¢ +90°.

5% Angular width ratio at the 5% clip level (% of
peak).

13.5% Angular width ratio at the 13.5% clip level (%
of peak).

50% Angular width ratio at the 50% clip level (% of
peak).

User % Angular width ratio at the user specified clip
level (% of peak).

Amplitude

Centroid Signal amplitude at the centroid.

Peak Signal amplitude at the peak.

User(deg) Signal amplitude at the user specified scan

angle. The angle range is [-90°, 90°].

Mode Field Diameter  Value of the MFD computed according to

FOTP191.
Axes... Opens the Time Statistics Axes dialog box for
setting the chart axes.
Time Stat Axes |
= Buis o L
ki kin Unitz
E o [ = [points 7]

b & b4 ax

I'I ) it |1 0 R gt
=] =l
Cancel |

Some of the options can also be selected using the Time Statistics window
toolbar.
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b Starts Data Collection.

[ Stops Data Acquisition.

x Clears and Resets the Time Statistics
Window.

= Turns the Grid Overlay On or Off.

X Turns the Statistic Calculation Overlay Text
On or Off.

w2 Opens the Time Statistics Parameter Dialog
Box.

= Turns the Axes Overlay On or Off.

7.6.8. Power

Open the Power window. The Power window displays a graph of the
cumulative angular power, numerical values (up to 3) of the power within
specified cone angles, numerical values (up to 3) of the cone angles
containing specified percentages of the total power, and the 8 and ¢ values
of the angular 3D centroid of the profile. The cumulative power graph and
associated parameters are determined along either the instrument optical
axis or the 3D centroid axis.

|"& Power - Photon Inc. M= E3

[ 2] {11

Power in cones around optical axis (mAf) Total Power (mW)  1.000

POWER WITHIN COME
5.0° 0.175
10.0° 0.480
45.0° 0.993

CONE WATH % POWER
25.00 % 6.221°
50.00 % 10.373°
#5.00 % 16.308°

JD CENTROID
Theta

Phi
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The Options Menu available when the Power window is active is shown

below. The selections are:

Optical Axis

Centroid

Parameters...

Power Parameters

Power within cane
¥ Core sngle [
¥ Core sngle [
¥ Core sngle [

I—
|1 0 v Power [%]: |5|:|
I—

Options

v [Optical Axis
Centroid

Parameters. ..
Colors. ..

When selected, the power calculations are
performed about the instrument optical axis.

When selected, the power calculations are
performed about the 3D centroid axis.

Opens the Power Parameters dialog for
selecting up to 3 cone angles for reporting
"Power within cone", and up to 3 percentages
of the total power for reporting the "Cones with
% power". Angles can be entered in degrees or
as Numerical Aperture if the "Display angle as
NA" box is checked. In this case the angles will
also be reported as NA in the Power window.

|
Cone with = power

5 v Power [%]: |25 — |

45 v Power [%]: |?5

[T Display angle az M
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Colors... Opens a Colors dialog box, used for selecting
the color scheme for the Power window. Colors
for the background, text, grid and data can be
independently set. To change a color, click on
the appropriate color “button” to open a
Windows color selection dialog box.

Colos |

B ackground |
T ext color o .
Gnid colar | ﬂl
D ata -

The options can also be selected using the Power window toolbar.

s When selected, the power calculations are
performed about the instrument optical axis.
A When selected, the power calculations are
performed about the 3D centroid axis.
w2 Opens the Power Parameters Dialog Box.
i1 Opens the Color Selection Dialog Box.
7.6.9. Notes

Opens the Notes Window used for entering user information.

= MNotes - Photon Inc. M=] &3

Euniumetric Radiometer =
anufacturing Test 10§15/1998

Diode S5/N 23854

Test Engineer JLG

Kl el

7.7. Status Bar

The Status Bar, shown below, appears at the bottom of the main window.
The value for the Aperture-Source Distance, the gain setting, and the
detector type are reported here.

ForHelp, press F |Distance: 0.20  [Gain: 84  |Detector: InGaAs 4
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7.8. Toolbars

Toolbars are provided to speed access to some of the most commonly used
operations and features of the Goniometric Radiometer program. Instead of
accessing these features through the pull-down menus, simply click on the
appropriate icon buttons on the toolbars. The operations and features
include: opening windows, turning data collection on and off, selecting the
scan mode, and selecting options. In addition, some file handling operations
such as opening and saving files, opening new files, and printing can be
initiated in this way. General program features are accessed on the main
toolbar, while options features specific to each window are accessed on
local window toolbars. For user convenience and preference, toolbars can
be placed at different screen locations by “dragging and dropping”.

The main toolbar and descriptions of the icon buttons and functions are
given below. The local window options toolbars were described previously
under the individual window descriptions.

Ee=Sh? ) » [ 1 L] 47 &5 RO

X

New File, opens a new file

File Open, opens a stored file
Saves the current file

Prints the current screen
Opens the Help Menu
Performs an AutoGain

Starts/Stops Data Collection for Single Axis
and Perpendicular Axes Scan Mode

Selects Single Axis Scan Mode
Selects Perpendicular Axes Scan Mode

Replay 3D Scan Data

A=Y LUHODEI
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3D Scan Mode; starts a 3D Acquisition
Replay 3D Centroid Data

Opens the Rectangular View Window
Opens the Polar View Window

Opens the 3D Polar View Window
Opens the 3D Rectangular View Window

Opens the Topographic View Window

Opens the Beam Statistics Window

!%g Opens the Time Statistics window, up to 15
i can be opened

- Opens the Power window

e Opens the Notes window

7.9. System Messages

System messages alert the user to system actions, out-of-bound conditions,
and errors.

1. Scan Control and Data Acquisition Card Not Initialized

Goniometnc Radiometer

& Could not intialize board. Pleaze make sure all cables are connected and that the comect 1/0 address iz selected for the
board.

If after several attempts to start the program, this message continues to
appear, contact Spiricon.

2. Signal Saturated (Single Axis and Perpendicular Axes scan modes)
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Beam Information!

Signal is saturated!

Decrease the signal gain.

3. Signal Saturated (3D Scan Mode)

Goniometric R adiometer |

Signal iz zaturated|
Pleaze repeat the 30 measzurement with a lower zignal gain.

Decrease the signal gain.

4. Signal Level too Low (3D Scan Mode)

Goniometric B adiometer |

& Signal level iz too low. Increaze zignal gain.

Increase the signal gain.

5. 3D Acquisition Progress Bar

A0 Acquizition Progress

0% 100%

The acquisition can be cancelled by clicking on the “Cancel
Acquisition” button.

6. Motion Control Error (3D Scan Mode)
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Motion Control Poszition Failure |

Data may be carupted. Click the Bet button ko take anather data zet.

& Syztem diagnostics have determined an error in the motion control spstem,
[f failure persiztz, contact Photon @20 1-800-3PHOTOM.

Cancel |

7. Reset Procedure Warning
Procedure warning |
Thiz operation will rezet all data views.
Do you want ko continue?

Selecting “Yes” will void all previously acquired data.
8. File Logging
File Logging |
File name already exiztz!

Owenvrte | Cancel |

Data log file already exist.

9. Graph Reset

Time Statistics for Angular Width - Photon Inc. |

The graph contains data that will be erazed by this operation
Eraze ?

10. Program Prompt
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Program Terminating E |

& Leaving already?

11. RS-232 Communication Failure

Goniometric B adiometer |

0 Mo communication with Gonometnc B adiometer. Program aborted.

12. Invalid Vector Entry

Invalid Vector Entry |

& Crozg gections canhot be determined for thiz vectarl

The vector entered is out of bounds and the Computed Cross
Sections cannot be determined. Either make another selection or
close the Computed Cross Sections dialog.

13. Invalid Angular Limit

Invalid Angular Limit |

Angular Limit for integral computation exceeds the Field of View.
The angular limit was automatically zet ta 30.00°

The Integral Angular Limit is greater than the Field of View for the set
Aperture-Source Distance. Use the angular limit value to
automatically set or enter a new value.
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7.10. Active X Automation

It is possible to start, control and exit the Goniometric Radiometer
Acquisition and Analysis Software using ActiveX Automation. The software
is an automation server. You need to start the software at least once so that
the appropriate information can be added to your Windows registration
database. After that, you can start and operate the software using any
ActiveX Automation compliant client application.

The gonio32.tlb file in the Automation folder where the software has been
installed contains the prototypes of the interface function. You can open and
view the Type Library with an OLE viewer program.

A sample file, GonioRActiveX.xls, is written in Visual Basic for Applications
using Microsoft Excel. It demonstrates the use of some of the automation
methods the Goniometric Radiometer Acquisition and Analysis Software
exposes (see section 7.10.28).

The interface methods and properties that the Goniometric Radiometer
Acquisition and Analysis Software exports are explained below.

Note: This version of the Automation interface exports only the data from
the current scan. The current scan (scan at the current “Phi” angle) is
characterized by:

e the number of data points in the scam (profile). A typical value is
3241. This number is returned by the GetNumPts method,;

e the amplitude of each data point. The array of data point value
(amplitude) in the current scan is returned by the GetProfileData
method;

e the “Theta” angle that corresponds to each data point. The array of
angles in the current scan of each data point is returned by the
GetProfileAngle method.

7.10.1. AngularLimit

Property Type:

VT_R4 — Degrees value

Remarks:

Sets or retrieves the angular limits of integration of the Peterman Il Integral
(Mode - Field Diameter computation). For example, a value of 60 means the
integral is computed from —60° to 60°.

This property is only available with the LD8900R Model.
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7.10.2. ApertureSourceDistance

Property Type:

VT_R4 - aperture source distance in cm

Remarks:

Sets or retrieves the value of the distance between the datum plane of the
entrance aperture and your source. For a detailed description of the
significance of the aperture source distance, please read section 4.1.9.

7.10.3. AutoGain

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_NONE - none

Remarks:

Perform an Auto Gain (which automatically sets the amplifier gain) for the
scan from the current Phi (azimuth) angle.

7.10.4. BlindSpotCorrection

Property Type:

VT_BOOL - blind spot correction

Remarks:

Enables/disables blind spot correction. For a description of the “blind spot”,
please refer to section 5.5 and section 5.6.

7.10.5. Datalncrement

Property Type:

VT_I2 - increment to decimate scan data / angle

Remarks:

Set or retrieve the increment value for decimate scan data / angle. For
example, if you will set the increment to 10, data (angle) exported through
GetProfileData (GetThetaAngle) will be (usually) data from indexes 0, 10,
20, 30, 40, 50, ..., 3240. GetNumPts will return the real number of exported
points (which in this case will be 324 instead of 3241)

7.10.6. Exit

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_NONE - none

Remarks:

Closes the Goniometric Radiometer software application.
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7.10.7. GetCenter

Method Return Value:

VT_R4 - centroid position

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the centroid position in degrees.

This version of the Automation interface exports only the data from the
current scan.

7.10.8. GetCurrentPhi

Method Return Value:

VT_R4 — current Phi angle in degrees

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the current azimuth scan (Phi) angle in degrees.

This version of the Automation interface exports only the data from the
current scan.

7.10.9. GetMFD

Method Return Value:

VT_R4 — MFD value

Method Parameter List:

VTS_NONE - none

Remarks:

Computes and returns the mode-field diameter value.

If an error occurred, the returned mode-field diameter value will be 0.
This method is only available with the LD8900R model.

7.10.10. GetNA

Method Return Value:

VT_R4 - numerical aperture

Method Parameter List:

VTS_R4 - cliplevel used for numerical aperture computation as a percent
value (e.g. 13.5 for 13.5%).
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7.10.11. GetNumPts

Method Return Value:

VT_I2 - number of points.

Method Parameter List:

VTS_NONE - none

Remarks:

Returns how many data points are in the current scan.

This version of the Automation interface exports only the data from the
current scan. This value can be changed by setting an increment with
Datalncrement.

7.10.12. GetPeaklrradiance

Method Return Value:

VT_R4 - value of the irradiance of the peak.

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the irradiance of the peak in counts. Possible value are 0...65535.
This version of the Automation interface exports only the data from the
current scan.

7.10.13. GetPeakPosition

Method Return Value:

VT_R4 - peak position

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the peak position in degrees.

This version of the Automation interface exports only the data from the
current scan.

7.10.14. GetPeakWidth

Method Return Value:

VT_R4 - angular width

Method Parameter List:

VTS_R4 - cliplevel used for angular width computation as a percent value
(e.g. 13.5 for 13.5%).

Remarks:

Returns the angular width in degrees. This version of the Automation
interface exports only the data from the current scan.
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7.10.15. GetProfileAngle

Method Return Value:

VT_VARIANT - profile angle array

Method Parameter List:

VTS_NONE - none

Remarks:

Returns an array of angle value points that represents the angle in radians
for each data point. The number of points in the returned data array is the
number returned by the GetNumPts method. Please note that the array of
angle values changes each time you change the aperture-source distance,
because the latter parameter affects the Field of View (refer to section 5.2).
This version of the Automation interface exports only the data from the
current scan.

7.10.16. GetProfileData

Method Return Value:

VT_VARIANT - profile data array

Method Parameter List:

VTS_NONE - none

Remarks:

Returns an array of data points that represents the profile in counts. The
number of points in the returned data array is the number returned by the
GetNumPts method. To get the correct distribution of the data, you need to
call GetProfileAngle, to get the theta angle value that corresponds to each
data point.

This version of the Automation interface exports only the data from the
current scan.

7.10.17. Go90Deg

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_BOOL - direction flag

Remarks:

Changes the azimuth scan angle by + or — 90° for data acquisition and
computing. When the parameter is TRUE the azimuth scan angle increases
by 90° (e.g. from 0° to 90°) and when the parameter is FALSE the azimuth
scan angle decreases by 90° (e.g. from 90° to 0°). This function operates
without any home checking routine. It is recommended occasionally to
check for “Home Position” with MotorGoHome.
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7.10.18. GoToPhiAngle

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS_R4 - value of phi angle in degrees. Possible values are 0°...180°.
Remarks:

Selects the azimuth scan angle for which data will be acquired and
computed. When the Goniometric Radiometer software is running as an
ActiveX server, the scanning data mode should be set to the default value of
“Single Axis Scan”. The “current” data acquired is the data for the selected
phi (azimuth) angle. Phi values are form 0° to 180°, in increments of 0.225°.
If the Phi value used as parameter is not a multiple of 0.225°, the closest
value smaller than the selected Phi value will be used.

7.10.19. IncrementPhi

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS _I2 — number of azimuthal scans intended to be performed for a 3D
acquisition. Possible values are 10, 20, 50, 100, or 200.

Remarks:

Incrementally moves the entrance aperture by the Phi angle corresponding
to the specified number of scans (e.g. 18° for 10 scans, 9° for 20 scans
etc.), useful for 3D data acquisition. After the entrance aperture is moved the
system automatically acquires and processes one scan at the previously set
gain, independent of the status of ScanAcquisition. As a consequence, the
user can get the new data set without switching ScanAcquisition on and
off. At the end of a 3D acquisition sequence it is recommended to return the
entrance aperture to the “Home Position” with MotorGoHome and check
the return value in order to ensure the data was acquired at the proper
azimuth angles.

7.10.20. IsSaturated

Method Return Value:

VT _BOOL - saturation flag

Method Parameter List:

VTS _NONE - none

Remarks:

Returns TRUE if signal is saturated, FALSE otherwise.
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7.10.21. MotorGoHome

Method Return Value:

VT_BOOL - flag

Method Parameter List:

VTS_NONE - none

Remarks:

Sets the system to the 0° azimuth angle. The difference between
MotorGoHome and GoToPhiAngle with an input value of 0°is that during
the MotorGoHome routine, an extra hardware check insures the correctness
of the 0° azimuth angle. The FALSE value returned in flag specifies if there
has been detected an error in the motion control system when trying to
move the motor from the previously selected Phi angle to the home position.
You may want to call this function in your program to check the motion
control system is working properly. You should call this function after a call
to GoToPhiAngle with a phi parameter value different than 0. If this function
consistently returns FALSE, contact Ophir-Spiricon.

7.10.22. PulsedMode

Property Type:
VT_BOOL - pulsed mode
Remarks:

Set or retrieve the pulsed mode of operation.

7.10.23. ScanAcquisition

Property Type:

VT_BOOL - global data acquisition

Remarks:

Sets or retrieves the status of data acquisition. If the value is TRUE, the
system is acquiring data.

7.10.24. ShowWindow

Property Type:
VT_BOOL - show flag
Remarks:

Shows or hides the Goniometric Radiometer Acquisition and Analysis
Software main window. Call this function with FALSE as parameter to hide
the Goniometric Radiometer Software. Call this function with TRUE if you
want to show the Goniometric Radiometer window.
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7.10.25. SignalGain

Property Type:

VT _I2 - signal gain value in dB

Remarks:

Sets or retrieves the value of the signal gains in dB.

Possible values are 0...139 for InGaAs detector and 0...159 for Si detector.

7.10.26. SourceFrequency

Property Type:

VT_R4 - source frequency in kHz

Remarks:

Set or retrieve the pulse repetition frequency of the source.

7.10.27. Wavelength

Property Type:

VT_R4 — Wavelength value

Remarks:

Sets or retrieves the wavelength value used in computations.
This property is only available with the LD8900R Model.

7.10.28. Sample file for ActiveX

Please note that in order to get correct numbers, you need to

e Setup the software to acquire data

e Set the correct aperture-source distance

e Select a reasonable signal gain

e Determine and set the azimuth angle for which data is acquired and

computed

Now, you can query the Goniometric Radiometer software for computed
values such as angular width, centroid and peak position of the distribution,
raw scan data for a selected azimuth angle, etc.
These are fragments from Visual Basic code that show how to use some of
the automation interface functions:

Dim Gonio As Object

Sub OpenSW ()
Set Gonio = GetObject ("", "Gonio.Document")
' start Goniometric Radiometer application and

' get a reference to the ActiveX object
Gonio.ScanAcquisition True

' start (enable) data acquisition
Gonio.ApertureSourceDistance 0.1

' tell software that the distance between the
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' source and the aperture is 0.lcm
Gonio.SignalGain /7

' set the signal gain to 77dB
Gonio.GoToPhiAngle 90
' 'go to azimuth angle phi=90°. (set the
software to

''acquire data for an azimuth angle of 90 deg)

End Sub

Sub CloseSW ()
Gonio.Exit

' close the Goniometric Radiometer software

End Sub

Sub GetwWidth ()
ActiveSheet.Cells(1l,1) .Formula =
Gonio.GetPeakWidth (13.5)

' get the angular width at 13.5% and display it
in

'‘'a cell in the active spreadsheet. The return

' value can also be written to a variable and

' used later in the program

End Sub

Sub GetCenter ()
ActiveSheet.Cells (2, 1) .Formula = Gonio.GetCenter ()

' get the centroid position and display it in a
‘'cell in the active spreadsheet. The return
' value can also be written to a variable and

' used later in the program

End Sub

For a detailed example written in Visual Basic, please refer to the
GonioRActiveX.xlIs file located under Automation, in the folder where the
software has been installed.

7.10.29. Sample file for C#

An example is provided that utilizes the .NET runtime engine. Developers
utilizing .NET technologies will find this example useful for interfacing with the
Goniometeric Radiometer whether they are using C# or another .NET
programming language.

To run this example you will need Visual Studio 2012. Microsoft provides a free
version, Visual Studio 2012 Express, which can be found at:
<http://www.microsoft.com/visualstudio/eng/products/visual-studio-express-
products >
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This example demonstrates a subset of all of the ActiveX methods using the
Gonio_Interop.dll library. The interop library must be referenced in your
automation project. The interop library exposes the COM accessible methods
and properties normally available in the Goniometric Radiometer to strongly-
typed languages such as C#.
Also provided in this example is a file named Imports.cs. The imports file
provides access to each of the methods and properties exposed by the
Gonio_Interop. In a C# project this file may be included and deployed with your
automation project. In other .NET languages a similar import file must be
generated, using the imports file as a template.
This example should provide the programmer with an understanding of how to
use the remaining methods.
Please note that in order to get correct numbers, you need to

e Setup the software to acquire data

e Set the correct aperture-source distance

e Select a reasonable signal gain

e Determine and set the azimuth angle for which data is acquired and

computed
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